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About This Book

This book describes how to install, configure, and start Personal
Communications. After you get Personal Communications up and running
and begin to perform various tasks, use online help.

This book is for users of IBM Personal Communications Version 4.3 for OS/2;
this product supports connections to AS/400, S/390, and S/3X hosts. In this
publication, the following terms are used to denote functions unique to the
particular host environment:

PC400 AS/400 host

PC/3270 S/390 host

See “What’s in the Packages” on page xii for information regarding what is in
each package.

The windows in this book are representative of ones that you might see while
working with Personal Communications. Minor variations could occur
between what you see on your display and what is in the book.

Text Conventions Used in This Book

This book uses the following text conventions:

UPPERCASE
Uppercase indicates commands, program keywords, and default
values. You can enter these values in uppercase or lowercase.

Bold Bold type indicates the names of window controls, such as lists, check
boxes, entry fields, menu choices, and push buttons.

Italics Italics indicate:
v Special emphasis in text or a reference citation.
v Variables that you supply a value for.

Example type
Example type indicates information that the user is instructed to type
at a command prompt or in a window.

This book also uses icons (pictures) in the text to help you find different types
of information.
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This icon represents a note, important information that can affect the
operation of Personal Communications or the completion of a task.

This icon represents a hint or additional information that can help you
complete a task.

What’s in the Packages

IBM Personal Communications Version 4.3 provides a CD-ROM containing
IBM Personal Communications Version 4.3 for OS/2, which provides 3270 and
5250 emulation and connections to S/390, AS/400, and S/3X host systems; it
also contains:.
v Certain corequisite products to use with the Personal Communications

product
v Book files in Portable Document Format (PDF), which allow you to print

the books shipped with the products
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Chapter 1. Welcome to Personal Communications for OS/2

Personal Communications Version 4.3 for OS/2 is the successor to Personal
Communications Version 4.2 for OS/2, which offered for the first time a fully
integrated client combining the emulation features of Personal
Communications with the OS/2 Access Feature to provide a wide variety of
connectivity services and application programming interfaces (APIs). The
OS/2 Access Feature, derived from Communications Manager/2, provides a
natural migration path for users of Communications Manager/2 seeking a
familiar client environment supporting upward compatibility for applications.
The evolution of the Personal Communications product is illustrated in
Figure 1 .

Personal Communications Version 4.3 uses an integrated installation and
configuration (first introduced in Version 4.2) designed for users migrating
from CM/2. This provides the user a single step operation offering a variety
of options to manage the client desktop configuration. Configuration dialogs
are provided for many configurations using the Access Feature, which allow
the user to create a configuration with the minimum number of parameter

Figure 1. Evolution of the Personal Communications for OS/2 product
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selections. For users that require support for additional communication
protocols, such as X.25, ISDN, IDLC, or advanced SNA functions such as High
Performance Routing (HPR), a configuration selection is provided that will
allow the user to access the familiar OS/2 Access Feature configuration
panels.

Note

The terms OS/2 Access Feature and Access Feature are used
interchangeably in this book.

What’s New in this Edition

Additional enhancements for Personal Communications Version 4.3 for OS/2
include:
v Support for Secure Sockets Layer (SSL).
v Support for Java programming using:

– Javabeans
– Host Access Class Library

Euro Sign
Code page tables have been changed to support the new euro sign.

Printer support for this currency sign depends on the printer and
printer driver supporting it.

New code pages
Personal Communications Version 4.3 extends the additional support
provided in service updates for Version 4.2, and now provides new or
updated support for these code pages:
v 420 (Arabic)
v 424 (Israel)
v 838 (Thailand)
v 1047 (Latin 1 Open Systems)
v 1140 (Canada, Netherlands, Portugal, U. S.
v 1141 (Austria, Germany)
v 1142 (Denmark, Norway)
v 1143 (Finland, Sweden)
v 1144 (Italy)
v 1145 (Latin America, Spain)
v 1146 (United Kingdom)

2 Personal Communications Quick Beginnings



v 1147 (France)
v 1148 (International)
v 1149 (Iceland)
v 1153 (Latin 2)
v 1154 (Cyrillic)
v 1155 (Latin 5 —Turkey)
v 1160 (Thailand)
v Personal Communications now uses the IBM CDRA Tables (for

SBCS versions only).

Personal Communications Folder

When you install Personal Communications, the main functions that you can
use are displayed as icons:

Start/Configure Session

Use this icon to set up the link configuration, as well as other
attachment information. You need this information to establish
communication with the host system. After you configure the link,
you can save the configuration to a workstation profile (*.WS) and
create an icon for that session. Later, you can click the new icon to
start the session, using your saved configuration.

Multiple Sessions

Use this icon to create batch files (*.BCH) that specify multiple host
sessions (workstation profiles) or other programs that you want to
start concurrently. Again, you can create an icon for each batch file
and start the programs just by clicking the icon.

Data Transfer (PC400 only)

Use this icon to transfer data between a workstation and an AS/400
database.
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Shared Folders (PC400 only)

Use this icon to share AS/400 folders with a workstation. Using this
function provides access to eight virtual workstation drives, allowing
the information in the AS/400 folders to be accessed as if it were
stored at the workstation.

In addition, icons are provided to link some of the Access Feature
utilities into Personal Communications so the user is not required to
go to the OS/2 Access Feature folder. Some examples are:
v Start Access Feature
v Stop Access Feature normally
v Stop Access Feature abnormally
v Access Feature configuration

Administration Tools

These are:

Menu-Bar-Customization Utility
Customize the menu bar in the workstation window

Configuration and Program Options
Add or remove program components or communication
drivers, or enable or disable DOS APIs or utilities

Maintenance Aid
Gather service information, or install a corrective service
distribution (CSD) or APAR fixes

Trace Services
Capture communication-protocol information that passes
between workstations and gateways or host systems to resolve
communication problems

Dump Formatter
Formats alerts and dumps. Alerts are logged to
EPWALERT.DAT.

Message Log Formatter
The FFST/2 message log utility allows you to display error
messages. Messages that occur during runtime are logged into
the default message log, which is OS2MLOG.DAT.
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System Error Log
Logs system errors during initialization and operation

Subsystem Management
Monitors and controls the status of Access Feature
communication resources

Adapter-Status Reporter
Display the status of the local area network (LAN) adapter in
the workstation

Certificate Management

Use this icon to enable Secure Sockets Layer (SSL)
communication between your communication server and
client. Refer to Personal Communications Reference for details on
how to use this utility.

Certificate Wizard

Use this icon to launch the Certificate Wizard which allows
you to enable Secure Sockets Layer (SSL) communication
between your communications server and client. Refer to
Personal Communications Reference for details on how to use
this utility.

Productivity Tools

These are:

ALMCOPY (PC/3270 only)
Send single or multiple files to or from VM 3270 sessions with
the high-speed file transfer program, ALMCOPY. You can also
use an asterisk as a wild card in place of characters in file
names or file types.

For detailed information, refer to ALMCOPY.DOC in the
PCOMOS2 directory.

ACPM (PC/3270 only)
Use ALMCOPY from a window instead of an OS/2 command
prompt.

Chapter 1. Welcome to Personal Communications for OS/2 5



For detailed information, refer to ACPM.DOC in the
PCOMOS2 directory. Note that this productivity aid is
provided AS IS and is not supported by IBM Service.

EasyREXX for HLLAPI
Create a REXX/HLLAPI program by using menus in a
programming window. In this window, you can create or edit
a file, record emulator operations into a REXX program, or
use interactive programming to develop a REXX program.

For detailed information, refer to PCSRXHLL.DOC in the
PCOMOS2 directory.

CMMouse
You can define mouse buttons to perform any sequence of
host keystrokes, including PF keys and special emulator
control keys. You can also build pop-up menus to control host
applications without any changes to those host programs.

Refer to the READ.ME file on the Personal Communications
CD-ROM for installation instructions.

CMRTM (PC/3270 only)
Monitor response time for 3270 sessions that require SNA
support

Refer to the READ.ME file on the Personal Communications
CD-ROM for installation instructions.

ZipPrint (PC/3270 only)
From a PC/3270 display session, print PROFS or OfficeVision
(OV) notes, calendars, documents, CMS files, XEDIT
workspaces, and session screens.

Readme - Please!

Use this icon to display supplementary information not contained in
the manuals, online help, or the Information notebook.

Personal Communications Sessions

The sessions that Personal Communications provides are logical connections
enabling communication between the workstation and host system. The
following types of sessions are available:

Display session
Lets you use your workstation as a display terminal connected to the
host system.
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Printer session
Lets you use a workstation printer as a host-system printer.

You can have up to 26 sessions running at once, depending on the Personal
Communications package you are using and the amount of memory in your
workstation.

Personal Communications Connections

Personal Communications provides a variety of connections to three types of
host systems:

S/390

AS/400

System/390 Connections
Personal Communications supports the following connections to a
System/390:

Interface Attachment

LAN

LAN via IEEE 802.2
LAN via NetWare** for SAA
Telnet3270

3270 via AS/400 (passthru)
APPC3270 via LAN

COAX
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SNA Distributed Function Terminal
Non-SNA Distributed Function Terminal
Control Unit Terminal (CUT)
3174 Peer Communication

COM
port

Hayes** AutoSync
SNA-over-Async
IBM Global Network Connection
Advantis (IIN)
Home3270

SDLC

Synchronous Data Link Control
3270 via AS/400 (passthru)
APPC3270 via SDLC

5250

3270 via AS/400 (passthru) (twinax)

Advanced 3270 Connections
Advanced APPC3270 Connections

AS/400 Connections
Personal Communications supports the following connections to an AS/400
system:
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Interface Attachment

LAN

LAN via IEEE 802.2 Telnet5250

SDLC

Synchronous Data Link Control

5250

Twinaxial Data Link Control (APPC)
Twinaxial Data Link Control (Console)

COM
port

SNA-over-ASYNC
SNA-over-ASYNC (Console)
Hayes AutoSync

Advanced 5250 connections

System/3X Connections
Personal Communications supports the following connection to a System/36
or System/38:

Interface Attachment

5250
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Twinaxial Data Link Control (Console)
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Chapter 2. Getting Ready to Install Personal
Communications

Personal Communications supports a wide range of workstations that use
different bus architectures and peripheral components. There are several
hardware and software requirements, as well as memory and storage
requirements, to consider when planning your installation.

The following sections list these requirements and the support for adapters,
keyboards, and printers.

Workstation Hardware

Personal Communications supports workstations with the following
hardware:

Table 1. Workstation Hardware Requirements

System unit The recommended system unit has an
Intel** 80486 ** or faster microprocessor
and access to a CD-ROM drive.

Display and display adapters Personal Communications supports
display monitors and video adapter cards
supported by OS/2.

Keyboards Personal Communications supports the
following keyboards:

v Enhanced keyboard (101-key, 102-key,
and 104-key)

v Space-saving keyboard

v Host-connected keyboard (122-key)

Printers Personal Communications supports the
same printers supported by OS/2 as well
as those supported by printer definition
tables (PDTs). (Refer to the Personal
Communications Reference for more
information.)
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Communication adapters Personal Communications supports the
same adapters for LAN attachments that
are supported by Multi-Protocol Transport
Services (MPTS). Refer to “Appendix A.
Communication Adapters and Modems”
on page 93 for a full list of
communication adapters supported by
Personal Communications.

Storage Requirements
You need at least 25 MB of disk space to install Personal Communications
However, if the connectivities you are using require SNA, you will need an
additional 15 to 25 MB for Access Feature functions.

Memory Requirements
The amount of memory you need to run Personal Communications (in
addition to the memory needed for OS/2) depends on several factors,
including the attachment type, number of sessions, and the use of such
programming interfaces as Emulator High Level Language Application
Programming Interface (EHLLAPI), dynamic data exchange (DDE), Java
beans, and HACL for Java.

Since OS/2 uses virtual memory management, the amount of memory can be
minimized if enough hard disk space is available for the SWAP file. Reducing
memory in this way is not recommended because of the performance
implications of swapping. It is recommended that at least 16 MB be used.

Workstation Software

Personal Communications requires that workstations have IBM OS/2 Version
4.0 or later installed.

Note: For Euro symbol support, you may require an additional fix pack; the
specifics vary by language.

Depending on your system configuration, the following software also might
be required:
v IBM Multi-Protocol Transport Services (included in this package), which

provides LAN and TCP/IP protocols.

Note: To utilize Secure Sockets Layer (SSL) support, you must install the
version included with Personal Communications Version 4.3.

v IBM TCP/IP Version 2.0 for OS/2 Base Kit or later (required for TCP/IP
attachments if you don’t have MPTS)
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v NetWare Client for OS/2 (required for LAN-via-NetWare-for-SAA
attachments)
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Chapter 3. Installing Personal Communications

Personal Communications provides several installation options. You can install
Personal Communications:
v Directly from CD-ROM
v From a network server
v By means of the configuration, installation, and distribution (CID) process,

using a response file. Response files are described in detail in the Personal
Communications Reference.

Personal Communications Installation Details

Introduction
This chapter describes how to install Personal Communications directly from
CD-ROM and over a network. Personal Communications provides an
installation guide to lead you through the installation process.

Notes:

1. Personal Communications will install the Access Feature components.
2. If Personal Communications V4.2 is found, Personal Communications

Version 4.3 will be installed, replacing the previous version. By default, the
same directory will be used for the installation. All Personal
Communications files in the private directory will be retained. The Access
Feature will also be reinstalled.

Note

If you install Version 4.3 on a system that previous had
Version 4.2 sessions configured, you must use the
configuration process after installing Version 4.3 – in order to
ensure that all required device drivers are installed and
operational.

3. If Communications Server for OS/2 V5.0 or later is found, Personal
Communications will be installed, but Access Feature will not be installed.
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Instead, the SNA communications subsystem from Communications Server
will be used. If Communications Server for OS/2 is found, only Advanced
Configuration can be used.

Direct Installation from CD-ROM

Note

You can also use the Personal Communications CD-ROM to go
directly to the Personal Communications web page.

To install Personal Communications on your workstation from CD-ROM:

Note: These instructions are for Personal Communications only; the
companion product installation is not described here.

1. Insert the Personal Communications CD-ROM into the CD-ROM drive.
2. At an OS/2 command prompt, type the following commands to change

to the CD-ROM drive and correct path:
E:
cd \os2\install\emulator
install

(where E: is your CD-ROM drive).
3. The Personal Communications logo window appears, followed by a

welcome message
4. Select the emulator you want to install. Access Feature will be included

in this installation. You may also choose to install just the Access Feature.
5. Select the drive and directory into which Personal Communications will

be installed. Also, select the drive that will be used for Access Feature.
(Access Feature is installed in the CMLIB directory.)

6. Select the installation type. The choices are:
v Full installation plus Access Feature documentation
v Full installation (the default)
v Selective installation
v Minimal installation

7. If Selective installation was chosen, you now select among the many
installation options that are available. These include: support for various
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connectivities and APIs, sample programs, PDF/PDT files for various
printers,and Personal Communications documents.

8. That completes the installation dialog. Once you have clicked on Finish
the actual installation of the files begins. The Access Feature files will be
installed first, followed by the Personal Communications files. Also,
during this phase, selected Communications Manager configuration files
may be migrated.

9. After all the files are copied to your workstation, a message appears to to
tell you that the Personal Communications folder has been created.
The Personal Communications folder appears on your desktop.

10. This completes the installation of Personal Communications; an
informational message may appear to tell you that you need to shut
down OS/2 and restart your workstation before you can use Personal
Communications.

Network Installation
If you want to install Personal Communications from a network server, such
as an IBM OS/2 LAN server or NetWare server, install the Personal
Communications files on the network server first.

Installing Personal Communications Files on a Network Server

Personal Communications provides an administrative installation option for
installing files on a network server. When you use this option, Personal
Communications copies the files from the CD-ROM to the network drive and
renames them.

To install Personal Communications with the administrative option, enter
INSTALL /A from an OS/2 command prompt.

Installing Personal Communications from a Network Server

If your system administrator has installed the Personal Communications files
on a network server, you can install Personal Communications from the server
to your workstation.

Although you can install Personal Communications from the network in the
same manner as from CD-ROM, there is a network installation option that lets
you share the program files on a network server with other users. When you
use the network option, the ″private″ files are installed on your workstation or
on your ″home″ directory on the server. Also, the Access Feature files are
installed on your workstation.

To install Personal Communications with the network installation option,
enter: INSTALL /N from an OS/2 command prompt.
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Installation Command Parameters
Enter the INSTALL command from an OS/2 command prompt.

Installation Parameters

v To install Personal Communications files on a server, enter:
INSTALL /A

v To install Personal Communications files from a server and to keep
only the private files either on your workstation or on your ″home″
directory on the server, enter:
INSTALL /N

v To install Personal Communications by using response files (using
CID), enter:
INSTALL /R: (full path of a response file)

v To remove Personal Communications files from your workstation,
enter:
INSTALL /D

v To view help for the INSTALL command, enter:
INSTALL ?

v To have an unattended network installation of Personal
Communications, enter:
INSTALL /Q /R: (full path of a response file)

Removing Personal Communications

You can remove Personal Communications from your workstation at any time;
to do so, enter the following command from an OS/2 command prompt:

INSTALL /D /T=C:\PCOMOS2

where:

/D Removes the product files and directories, the folder, the icons, and
the entries from system files such as CONFIG.SYS and PCOMOS2.INI.

/T Indicates the path from which the files should be removed. If you do
not add this parameter, the files are removed from the path indicated
in PCOMOS2.INI.

C:\PCOMOS2
Indicates the drive and directory in which Personal Communications
is installed.
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Chapter 4. Configuring Sessions

This chapter describes how to configure a session to have the type of
connection, screen size, and other attributes that you want. It also describes
how to save the session definitions in a profile.

Personal Communications Version 4.3 for OS/2has a user interface to create a
configuration which fully integrates the OS/2 Access Feature, which was
previously provided as a separately installable option. A configuration dialog
is a series of configuration panels that guide you through the configuration
process with a minimal amount of input required. Configuration of basic
sessions includes configuration dialogs to simplify the task of configuring
many basic connectivities. Additional connectivities and advanced
configuration parameters that are not supported by the configuration dialogs
are defined using an integrated set of Personal Communications and OS/2
Access Feature configuration panels.

To communicate with a host system successfully, you must create a
configuration for the connections you want to establish. The term configuration
represents all of the configuration files associated with a specific workstation
configuration. The number and type of configuration files depend on the
actual workstation configuration. A configuration consists of emulator
definitions such as keyboard and color mapping, and communications
definitions such as LAN address and CP name. Personal Communications
saves this configuration information in a workstation profile (*.WS). This
profile can be used later by other Personal Communications sessions. For
certain types of configurations that require SNA connectivities (LAN and
SDLC), Access Feature configuration files (.RSP, .CFG, .CF2, .NDF, and .SEC)
will be stored in \CMLIB.

Note

If you are using a 3270 or 5250 PCMCIA card, refer to “Installing
PCMCIA Support” on page 99 before continuing configuration.
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Configuring PC400 and 3270

To connect PC400 to an AS/400 system or S/390 specific
configuration information in the workstation profile must
correspond to the information specified at the host system.

Configuring Basic Sessions

For many connectivities, creating a basic configuration uses simple
configuration dialogs. Each dialog guides you through a configuration process
using the most commonly specified parameters. These parameters are
displayed on a summary panel at the end of the configuration dialog path.
You can modify these parameters from the summary panel, thus eliminating
the need to use the Advanced configuration path to define these parameters.
A configuration dialog requires only a minimum amount of user input to
allow you to get up and running quickly. If you are familiar with
Communications Manager/2 or the OS/2 Access Feature, the Personal
Communications dialogs are equivalent to the Quick Configuration process
for those products.

For other types of connectivities where a configuration dialog is not available,
creating configurations involves specifying values for the parameters listed on
each panel.

Attachment Types With Configuration Dialogs

Note

If you install Version 4.3 on a system that previous had Version
4.2 sessions configured, you must use the configuration process
after installing Version 4.3 – in order to ensure that all required
device drivers are installed and operational.

20 Personal Communications Quick Beginnings



Table 1 lists the various attachment types available and identifies the
attachments where the configuration path is guided by a configuration dialog.
When you select one of these attachments types for the interfaces and hosts
listed, the configuration dialog provides as defaults many of the most
commonly used parameters.

Table 1. Attachment types with corresponding configuration dialogs

Interface Attachment Host Config
Dialogs

LAN LAN Via IEEE 802.2 S/390
AS400

U U

LAN LAN via NetWare for SAA S/390

LAN Telnet3270 S/390
AS400

LAN 3270 via AS/400 S/390 U

LAN APPC3270 via LAN S/390 U

COAX SNA Distributed Function Terminal S/390

COAX Non-SNA Distributed Function Terminal S/390

COAX Control Unit Terminal S/390

COAX 3174 Peer Communication S/390 U

COM PORT Hayes AutoSync S/390
AS/400

U U

COM PORT SNA over ASYNC S/390
AS400

U U

COM PORT IBM Global Network S/390

COM PORT Home3270 S/390

COM PORT Advantis S/390

COM PORT SNA over ASYNC (Console) AS400

5250 3270 via AS/400 S/390

5250 Twinaxial Data Link Control (APPC) AS400

5250 Twinaxial Data Link Control (Console) AS400
S/390

SDLC Synchronous Data Link Control S/390
AS400

U U

SDLC 3270 via AS/400 S390 U

SDLC APPC3270 via SDLC S390 U

For connectivities that are created using a configuration dialog, a workstation
profile (*.WS) is created and saved in the \PCOMOS2 directory. The Access
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Feature configuration files, including a response file (*.RSP), are created and
saved by default in the \CMLIB directory.

A response file, which is also an ASCII configuration file for the OS/2 Access
Feature, can be used to upgrade or change configuration parameters. A
response file is created for each configuration that uses a configuration dialog.
For example, when a configuration with the name configname is successfully
verified, information about that configuration is recorded into the file
configname.RSP. If you want to modify your configuration without repeating
the configuration dialog process, you can directly edit the response file.

The OS/2 Access Feature provides the CMRECORD utility that creates a
response file from a configuration. You can also create a response file by
editing a response file and adding the configuration information.

If you modify an existing response file, you can apply your changes to the
configuration by typing CMSETUP /R response_file.

See the Communications Server for OS/2 Response File Reference for more
information on using response files to create a configuration.

Basic Configuration Steps
To configure a basic session:
1. Double-click the Start/Configure Session icon in the Personal

Communications folder.
The logo panel appears, followed by a welcome message.

2. Select OK to confirm that you want to start configuration.
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The Customize Communication window overlays the blank session
window.

A list of host types is displayed. The host types that are displayed depend
on the Personal Communications option you select during installation
(3270 emulator only, 5250 emulator only, or both 3270 and 5250 emulation).

The possible host types are:
v S/390 for connections to an S/390 system
v AS/400 for connections to an AS/400 system
v S/3X for connections to a System/36 or System/38

3. Select a host type from the list.
4. Click the adapter card (Interface) that you will use; the attachment types

that can be used with this adapter are displayed.
5. Click the attachment type to be used.
6. Select Configure...

The Customize Communication - xxxxx window is displayed. (xxxxx
represents the attachment type for each session.)
For information on each parameter, select Help.
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Note: If you want to enable data compression or session-level encryption,
select Configure SNA. This push-button does not appear for all
attachment types.

7. Select Configure Link.
a. If the connectivity you selected on the Customize Communication

window is not supported by a configuration dialog, you are prompted
to provide values for all parameters on the configuration panels that
are displayed.

b. If the connectivity you selected on the Customize Communication
window is supported by a configuration dialog, the first in a series of
configuration dialog panels is displayed. This initial panel allows you
to specify the name for the configuration you are creating or
modifying. The configuration dialog looks for the following
configuration file names in the order listed below, and depending on
which is found first, displays that configuration name as the default
name on this panel:
1) The configuration file name saved in the .WS file
2) The active configuration file name
3) The default configuration file name

If you do not want to use the default name, specify another name, or
select Browse to view a list of existing configuration file names.

Note: If you want to run multiple emulator sessions concurrently, you
must use the same Access Feature configuration file for all
sessions. This applies only to connectivities that use the Access
Feature.

“Example Configuration Dialog” on page 25 shows an example of how
a configuration dialog guides you through the process to create a
configuration for a LAN connection for 3270.

If the configuration dialog detects it cannot support the configuration file
for the connectivity you selected on the Customize Communication panel,
the Advanced Configuration File dialog is displayed. This dialog lists the
possible reasons why the configuration is not supported. Select Advanced
to display the Advanced Connection panel, then select Configure LU
Definitions to continue with the advanced Access Feature configuration or
select Back to change the configuration file name. See “Configuring
Sessions for Advanced Functions” on page 28 for more information on
advanced configurations.

When you have finished entering values for your configuration, the
Customize Communication is displayed.
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8. Select OK on the Customize Communication window to return to the
session window.

9. If you have configured a connection that requires the installation of a
device or IFS driver, a message appears that lets you choose to install the
device or driver now or later.
a. If you select Yes, it is installed immediately. If you select No, you will

need to install it later with the Configuration and Program Options
utility in the Administration Tools folder.

Tip

Twinax and coaxial connections all require that a device
driver be installed. Also, before you can use Shared
Folders, an IFS driver must be installed. Therefore, if you
want to make changes such as these, which require you to
restart OS/2, make them now.

b. After the device or IFS driver is installed, shut down OS/2 and restart
your workstation so the connection can be established.

Your configuration is now complete. If you want to save it, refer to “Saving
Configuration Information” on page 44 for details.

Example Configuration Dialog
When you select a connectivity that uses a configuration dialog to guide you
through the configuration process, a series of panels similar those in this
section are displayed when you select Configure Link on the Customize
Communication window. This example illustrates the panels that are
displayed to configure a LAN connection for 3270.
1. Configuration information is recorded in a response file (.RSP) and is

stored in the \CMLIB directory. In this example, response file LAN.RSP is
stored in \CMLIB. Response files are also used by Communications Server
and the OS/2 Access Feature to define configurations. The response file
created in this example is equivalent to the response files used by those
products.
You can also select Browse to view a list of existing configuration files
(*.RSP) in the \CMLIB directory or in other directories.

Note: If you specify a response file on this panel that currently resides in
a directory other than \CMLIB, the updated Access Feature
configuration files, including the response file, will always be stored
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in \CMLIB.

2. Specify the information about your local system.
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3. On this panel, specify information about the local workstation and the
gateway in order for a connection to be established.

4. When you have entered all required information, the Review
Configuration panel is displayed to show a summary of the defined
parameters and the defaults used. If one of the defaults or user-defined
values is not correct, you can click on the value to display the
corresponding configuration panel for that value. For example, if you want
to change the value for LAN destination address, click on the value to the
right of that parameter.
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5. You are then returned to the Define Connection Information dialog where
you can modify the value for the selected parameter. Select OK to return
to the Review Configuration dialog.

When you select Done on the Review Configuration dialog, the Access
Feature CMSETUP /R command is issued to perform response file
processing and to create the Access Feature configuration files. The
Customize Communication window is once again displayed.

Configuring Sessions for Advanced Functions

The Customize Communication panel includes an Interface selection for
Advanced. The Advanced selection is used to support the following:
v Configurations for additional connectivities such as X.25, ISDN and GDLC.
v Configurations requiring selection of additional parameter specifications not

supported by the configuration dialogs, such as HPR, DLUR or multiple PU
support. This could apply to new configurations or existing configurations
that were created using configuration dialogs that need to be modified.

If the configuration dialogs detect a condition requiring the use of the
Advanced configuration path, a panel is displayed to notify you of the
conditions under which this might occur. These conditions include:
v The configuration you are configuring was created through the Advanced

interface option on the Customize Communications window.
v The configuration was created or modified with a text editor.
v The configuration contains information for a connection type that is

different from the connection type you selected to begin the configuration.
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Note

Some configuration panels in the Advanced selection may
contain references to Communications Manager. Personal
Communications configuration panels are reused from the OS/2
Access Feature and Communications Manager/2. If you have
installed and configured CM/2 or the OS/2 Access Feature,
these configuration panels will look familiar.

Configuration Steps for Advanced Functions
To configure for advanced functions:

1. Double-click the Start/Configure Session icon in the Personal
Communications folder.
The logo panel appears, followed by a welcome message.

2. Select OK to confirm that you want to start configuration.
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The Customize Communication window overlays the blank session
window.

A list of host types is displayed. The host types that are displayed
depend on the Personal Communications Option you select during
installation (3270 emulator only, 5250 emulator only, or both 3270 and
5250 emulation).

The possible host types are:
v S/390 for connections to an S/390 system
v AS/400 for connections to an AS/400 system
v S/3X for connections to a System/36 or System/38

3. Select a host type from the list.
4. Click the Advanced interface. The attachment types that can be used with

this adapter are displayed.
5. Click the attachment type to be used.
6. Select Configure...

The Customize Communication - xxxxx window appears. (xxxxx
represents the attachment type for each session.)
For information on each parameter, select Help.
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Note: If you want to enable data compression or session-level
encryption, select Configure SNA. This push-button is not
displayed for all attachment types.

7. Select Configure Link.
The Advanced Connections panel is displayed for the connection type
you selected.

8. Select Configure LU Definitions.
The Communications Manager Setup window is displayed. All
subsequent configuration panels are reused from the OS/2 Access
Feature.

9. Select Setup.
The Open Configuration window is displayed.

10. Type a configuration name, or select the configuration you want to
change. After you supply the required information and select OK, the
Configuration Definitions window is displayed. Refer to “Configuration
Definitions Window” for more information on completing the remaining
panel definitions.
Refer also to “Quick or Advanced Configuration” on page 34 for
information on how to use the Quick and Advanced configuration paths.

11. When you have finished, select OK on each window until you return to
the session window.
Your configuration is now complete. If you want to save it, refer to
“Saving Configuration Information” on page 44 for details.

Configuration Definitions Window
On the Configuration Definitions window, you can select either:
v Commonly used definitions

v Additional definitions

Commonly Used Definitions
When you select Commonly used definitions, the workstation connection
type and features or applications appear in a single list that contains the most
common configuration choices.

Select the definition that you want to configure. You can configure LUA and
APPC application programming interfaces (APIs) configurations that support
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application communications and 3270 and 5250 emulation.

Additional Definitions
When you select Additional definitions, all of the workstation connection
types are displayed in one list and all features and applications that are
available for the selected connection type appear in another list.

Select a connection type from the Workstation Connection Type list, and then
select your choices from the Feature or Application list for your configuration.

Selecting the Workstation Connection Type
The hardware detection feature makes a default connection type selection for
you. You can select a different connection type. If you make a different
connection type selection, the entries in the Feature or Application list might
change.

You can make only one selection from the Workstation Connection Type list. If
you have more than one connection type, complete the configuration profiles
for the first connection type and then repeat the configuration process.

Features or Applications
The Feature or Application list always displays the features and applications
that are available for the selected connection type. Select the features and
applications from the list. To select more than one, hold down the Ctrl key
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while selecting with your mouse. If you select more than one feature or
application, the quick configuration path will not be available.

After you make your choices from the connection type and features or
applications lists, select Configure. Depending on your selections, your see
either the quick or advanced configuration windows.

If you have several combinations of a connection type and features or
applications, you must configure them one at a time. Always return to the
Configuration Definitions window to choose another combination.

For each connection type, various features or applications are available. Use
the connection type table that follows to guide you with your selection of the
features or applications that you will install.

Connection Types and Related Features or Applications
The following table lists the workstation connection types and the features
associated with each that you can configure.

Note

APPC APIs provide support for 3270 and 5250 emulation and
application program communications. LUA APIs provide
support for 3270 emulation and application program
communications.

Connection Type ACDI
Redir.

APPC
APIs

APPC
for 5250
Support

CPI-C LUA
APIs

ACDI
APIs

X.25
APIs

LUA
with
DLUS

AnyNet SNA over
TCP/IP

U U U U U

Asynchronous U

DLUS using AnyNet U U U U

Ethernet (1) U U U U U U

Frame Relay (1) U U U U U U

ATM LAN Emulation
(1)

U U U U U U
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Connection Type ACDI
Redir.

APPC
APIs

APPC
for 5250
Support

CPI-C LUA
APIs

ACDI
APIs

X.25
APIs

LUA
with
DLUS

GDLC for
adapter-provided DLC

U U U U U

IDLC U U U U U

PC Network U U U U U U

SDLC U U U U U

Token-Ring (1) U U U U U U

Twinaxial U U U U U

X.25 U U U U U U

X.25 Using X.25
Coprocessor Adapter

U U U U U U

Note:

v Ethernet, Frame Relay, ATM LAN Emulation, and Token-Ring are configured through ″Token-Ring or
Other LAN Types″.

Quick or Advanced Configuration

If a quick configuration path is available, it is presented. If there is no quick
configuration path available, the advanced configuration path is presented.
For the quick configuration path, default values are provided for as many of
your configuration parameters as possible.

You can access the advanced configuration path by selecting Use advanced
configuration from the Options menu in the Configuration Definitions
window. When this option is selected, choosing Configure... presents you the
advanced configuration path, effectively bypassing the quick configuration
path.

Quick Configuration
The quick configuration path is available for the following scenarios:

Connection Type LUA APIs APPC APIs for
5250 Emulation
Support

APPC APIs

Ethernet U U U

PC Network U U U

SDLC U U

Token-Ring U U U

Twinaxial U
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When using a quick configuration, you enter values for a minimum number
of parameters into one window. The Communications Manager configuration
program supplies defaults for all other parameters.

Note: HPR is enabled for Ethernet and Token-Ring connection types as the
default.

If you change a default value through the advanced configuration path, the
quick configuration path might no longer be available for that configuration
definition. If this occurs, the advanced configuration path is presented. For
another configuration, you again have the quick configuration path available.

You can always create your initial configuration with the quick configuration
path, and expand the configuration at a later date with the advanced
configuration path. The reverse is generally not true. To access the advanced
configuration path from the quick configuration window, select Advanced....

Using the Quick Configuration
The following table lists the quick configuration parameters and the
connection types. Find your connection type and then read down to identify
the required (U) parameters and optional parameters (O). Contact your
administrator for assistance.

Parameter LAN
LUA

LAN
APPC

LAN
APPC -
5250
Emul.

Twin-
axial

SDLC
LUA

SDLC
APPC -
5250
Emul.

Connection to
network node
server

U U U

Controller address U

LAN destination
address

U U

Local node ID O O O O O

Local node name U U U U U U

Local node type U

Modem connection U U

Network ID U U U U U U

Network node
server address

U

Chapter 4. Configuring Sessions 35



Parameter LAN
LUA

LAN
APPC

LAN
APPC -
5250
Emul.

Twin-
axial

SDLC
LUA

SDLC
APPC -
5250
Emul.

Number of LUA
definitions

U U

Partner LU name U U U

PCMCIA
compatible
machine

U

Port name U

Secondary station
address

U U

Workstation
machine type

U

Notes:

1. LAN is for Token-Ring, Ethernet, and PC Network.
2. Twinaxial connection is for 5250 emulation on AS/400 computers

only.
3. Workstation machine type only appears when you are creating a

Twinaxial configuration for another workstation.

This is a brief description of the quick configuration parameters. For a more
detailed description, use the online help.

Connection to network node server
An indication that you are defining a link to a network node that
provides directory and routing services for your workstation on an
APPN network.

Controller address (number from 0 to 6)
The unique address that the host twinaxial controller uses to
recognize your workstation.

LAN destination address (12 hexadecimal digits)
The address of the adapter at the communication controller or
gateway on your network. Also called medium access control (MAC)
address. This address must match a value defined at the host.

Local node ID (up to 8 hexadecimal digits)
Used by SNA when the link between the host and your workstation is
activated. Also called IDNUM or known as your workstation’s
exchange ID (XID). The first three digits, 05D, are filled in for you. In
most cases, this ID must match a value defined at the host.
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Local node name (up to 8 characters)
The unique name of your workstation as it is known on your
network. Also called physical unit (PU) name or control point (CP)
name.

Local node type
The type of node that this workstation is. The node types are either
End node to network node server, End node - no network node server, or
Network node.

Modem connection
The type of line connected to the SDLC modem, either Synchronous
nonswitched - DTR dialed, Asynchronous switched, Asynchronous
nonswitched, Synchronous switched, Autosync, or ISDN.

Network ID (up to 8 characters)
The name of the network where your workstation is located; also
called NETID or network name. This ID must match a value defined
at the host.

Network node server address (12 hexadecimal digits)
The address for the LAN adapter on your network node server.

Number of LUA definitions (number from 1 to 253)
The number of logical unit application (LUA) definitions that you
want to define for this configuration.

Partner LU name
The fully qualified partner name of the logical unit (LU) on the host.
This parameter is the same as the host control point (CP) name. The
partner LU name consists of two names, up to 8 characters each,
separated by a period. This name must match a value defined at the
host.

PCMCIA compatible machine
An indication of whether the machine has a PCMCIA adapter card, a
PC adapter card, or a credit card adapter.

Port name
Identifies the communications hardware.

Secondary station address (2 hexadecimal digits)
The address of your workstation as it is known to the host. Use the
default value unless your administrator gives you a different one.

Workstation machine type
The type of machine that the configuration you are defining will run
on. This parameter only appears when you are creating a Twinaxial
configuration for another workstation. The machine types are Micro
Channel or ISA or AT-compatible.
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Hints on APPC APIs Quick Configuration

Tip

You can use quick configuration to configure APPC APIs using
the following connection types:
v Token-Ring or other LAN types
v Ethernet network
v PC Network

If the workstation will not be connecting from an end node to a network node
server, you need to define an SNA connection. Follow these steps:
1. Complete the entries in the quick configuration window for the connection

type that you selected.
2. Select Advanced....

The Communications Manager Profile List window appears.
3. Select SNA connections.

The Connections List window appears.
4. Select to Peer Node, then select Create...

The Adapter List window appears.
5. Select Continue....

The Connection to a Peer Node window appears.
6. Fill in Partner network ID and Partner node ID, then select Define

Partner LUs....
The Partner LUs window appears.

7. Complete the partner LU information.
If you need to define an APPC transaction program (TP), complete the
following steps:

8. From the Profile List window, select SNA features.
The SNA Features List window appears.

9. Select Transaction program definitions.

Advanced Configuration
If the quick configuration path is not available or if you selected to use the
advanced configuration path, the Communications Manager Profile List
window appears. A list of configuration profiles is presented to you based
upon the previously selected connection type and features or applications. Use
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the list in the window to guide you through the profiles that you need to
configure.

In the Action column in the Communications Manager Profile List window,
your profiles are identified as Required or Optional. Complete all the required
profiles. In a few situations, some profiles are identified as *Required.
Information displayed on the window indicates when you need to complete a
profile identified as *Required.

When you configure a profile, a check mark (U) is placed in front of the
Action column. When all of the required profiles have a check mark, return to
the Configuration Definitions window by selecting Close. Select the Close
push button on the Configuration Definitions window when you have
finished defining configurations.
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Additional Options on the Configuration Definitions Window

From the Configuration Definitions window, you have additional
configuration options.

From the Options pull-down menu, you can:
v Configure any profile or feature
v Change workstation information
v Change the advanced configuration path toggle
v Change the verify configuration toggle

From the Sockets pull-down menu you can configure Sockets over SNA
support when you select Configure....

Configuring Any Profile or Feature
You can view a list of all configuration profiles by selecting the Configure any
profile or feature... item in the Options drop-down menu in the Configuration
Definitions window. The Configuration List window is displayed.

Selecting an item from the list displays the same configuration windows as
used in the advanced configuration path. When you configure a profile, a
check mark (&check.) is placed before the item.

Unlike the advanced configuration path, you are not guided to the profiles
that are appropriate for your needs. With the advanced configuration path,
you have a short list of profiles that are specific to your connection type and
your features or applications. In addition, with the advanced path, each
profile in your list is identified as required or optional.

With the full configuration list, you must decide which profiles need to be
completed for your connection type and your feature or application. If you do
not complete all of the required profiles, verification of the configuration will
not be successful.

A Personal Communications specialist might want to use this path, but it
should be compared with the “Quick or Advanced Configuration” on page 34
.

Configuring the ARTIC Adapter Without X.25
This feature indicates whether your workstation uses a real-time interface
coprocessor (ARTIC) adapter that is not connected to an X.25 network. When
you select to use this feature, the interface files required to run the adapter are
loaded.

To access this feature, select Configure any profile or feature... from the
Options drop-down menu in the Configuration Definitions window.
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Configuring LAN Protocols Using ISDN
To access this feature, select Configure any profile or feature... from the
Options drop-down menu in the Configuration Definitions window.

The LAN protocol using ISDN profile indicates whether your ISDN
applications use any of the LAN protocols (IEEE 802.2 or NetBIOS, for
example) to establish connections. When you select this feature, the files
necessary to support ISDN connectivity are activated.

The LAN Protocols using ISDN profile requires installation of connection
manager IEEE 802.5 virtual MAC driver. This driver is provided on the
CD-ROM. MPTS must be installed before you can install and configure this
network adapter. The configuration is stored in the PROTOCOL.INI file.

Configuring LAN Over Coaxial Cable
If you are using a 3270 adapter for 3174 Peer Communications (LAN over
coaxial), select Token-ring or other LAN types as the type of connection.

You can configure for LU 6.2 and for support of 3270 emulation over the 3270
adapter for 3174 Peer Communications just as if this was a LAN adapter. Two
cards are not required; you can configure both LU 6.2 and 3270 over the same
adapter.

To set up a 3174 controller for Peer Communications, configure the
Configuration Support C feature and the 3174 Peer Communications device
driver for the 3270 adapter in MPTS or LAPS.

Changing the Workstation Information
You can change the workstation profile to specify the ASCII-to-EBCDIC (SBCS
) or JISCII-to-EBCDIC (DBCS) translation table file name and to automatically
load the services configured.

To change the workstation information, select Change workstation
information... from the Options menu in the Configuration Definitions
window.

Specifying a Translation Table File Name
An ASCII-to-EBCDIC (SBCS) translation table is provided to convert American
National Standard Code for Information Interchange (ASCII) to extended
binary-coded decimal interchange code (EBCDIC).

A standard default table is provided for these conversions. Do not type a file
name in this field unless you use a translation table other than the default
table.

Refer to Communications Server for OS/2 Quick Beginnings for more information
on translation tables.

Chapter 4. Configuring Sessions 41



Selecting Services to Be Loaded Automatically
You can specify that services used by the workstation configuration be
automatically loaded on a workstation each time communications start.

By default, each configured service is loaded on a workstation. If you do not
want a service loaded automatically, deselect the appropriate check box.

You must configure each service that you want to be loaded automatically on
a workstation. Selecting the service name in this list has no effect if the service
is not configured.

Changing the Advanced Configuration Path Toggle
A quick configuration path is available for many configuration definitions.
However, if you prefer to use the advanced configuration path, set the Use
advanced configuration option to On.

If the quick configuration window is presented, you can always access the
advanced path by selecting the Advanced... pushbutton. The advanced path
uses the Profile List window.

Note

The toggle setting is associated with each configuration. When
you change a configuration, the toggle is still set as you had
previously defined it.

Changing the Verify Configuration Toggle
The configuration must be verified before you can use it. If the configuration
is not verified, communications cannot start at a later time.

You might want to bypass automatic verification if you discover that you do
not have all of the necessary information to configure the required profiles.
When the information is available, you can restart the configuration program,
make the appropriate modifications, and then perform verification.

To toggle automatic verification, select Verify configuration from the Options
menu in the Configuration Definitions window. The default setting for this
toggle is On.
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Note

The toggle setting is associated with each configuration. When
you change a configuration, the toggle is still set as you had
previously defined it.

Configuring the Sockets over SNA Profile
The profile that is specific to configuring Sockets over SNA support is
accessed by selecting Configure... from the Sockets drop-down menu in the
Configuration Definitions window. See Communications Server for OS/2 Quick
Beginnings for further information on profiles.

Checking Values Window

The Checking Values window is displayed after you have created or modified
your configuration to indicate that CMSETUP is automatically verifying the
configuration.

All configuration verification messages are logged in the file
\CMLIB\VERIFY.LOG. If any errors are discovered when verifying a
configuration, a message is displayed. Select Show log to transfer control to
the FFST/2 Message Log Facility. Use the FFST/2 Message Log Facility to
read the VERIFY.LOG. file. Select OK on the Verify Configuration message to
return to the setup windows to make changes to your configuration.

When to Change or Add a Configuration

After Personal Communications is installed, you might have a need to change
your configuration if you:
v Change adapter cards
v Change network parameters
v Specify a new default configuration
v Change parameters affecting the CONFIG.SYS file

In general, changes to an active configuration do not become effective until
you stop and then restart. Use Table 2 on page 44as a guide to determine the
proper action to enable the changed configuration.
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Table 2. Enabling Changes in the Active Configuration

Kind of Change Action to Enable Change

Add any new feature Install the necessary product files. Stop
and restart communications.

Add a data link control (DLC) profile Install the necessary product files. Stop
and restart communications.

Change any SNA characteristic except
local node name, connection networks,
and SNA defaults

Verify and dynamically update SNA
resources or stop and restart
communications.

Change the CONFIG.SYS file Stop communications, shut down and
restart the workstation, then restart
communications.

Change the workstation information Stop and restart communications.

Change ACDI or X.25 Stop and restart communications.

If you receive a configuration from your network administrator, move it to an
appropriate directory, such as \CMLIB. Place all configuration files in the
same directory.

Saving Configuration Information

This section describes how to save configuration information to a workstation
profile (*.WS).

By default, Personal Communications saves your configuration when you exit
a session, but you can also save your configuration manually. When you save
your configuration, you can have a session icon added to the Personal
Communications folder that you can double-click to restart a session.

To save configuration information in a workstation profile:
1. Select Save or Save As from the File menu.

When you save an existing workstation profile with Save, the profile is
saved using the existing name. You need not do the following steps.
Otherwise, the Save Workstation Profile As window appears.

2. Enter a file name that you want this profile to be saved as.
The name you enter is used as the icon title, unless you enter a description
as well.

Note: When the file name is used for the icon title, it appears in lowercase
and is restricted to 8 characters.
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3. A message appears that lets you choose to have an icon created. If you
select Yes, a session icon is created in the Personal Communications folder
and you can start the workstation profile by double-clicking this icon.
If you select No, you can start the session window program (PCSWS.EXE)
with the workstation profile name (*.WS) on the OS/2 command prompt,
as follows:

C:\PCOMOS2\PCSWS C:\PCOMOS2\PRIVATE\xxx.WS

where xxx.WS is the workstation profile name.

Note that you must specify all paths and directories.

The configuration information is saved, and the message that tells you
how to start a session appears. Select OK.

To configure another session, select Run the Same from the File menu
and, if you want, change the configuration for that session.

Tip

If you want to start another session that is exactly like the
one that is already started, select Run the Same from the File
menu of the original session.

If you want to start a session that is exactly like one you
have saved but that is not started, select Run Other... from
the File menu of any session that is started. Select a profile
from the list that appears.

Changing Configuration Information

To change a profile:
1. Double-click the icon corresponding to the profile to be changed.

The session window appears.
2. Select Configure from the Communication menu.
3. The subsequent steps are the same as for setting up a new configuration.

Refer to “Configuring Basic Sessions” on page 20 and change the
configuration information as required.

4. After you make all the necessary changes, select OK in the Customize
Communication window.
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5. The following message might appear:
Because you have changed the configuration,
communication will be terminated if you
proceed. Are you sure?

If you select OK, communication ends, but then you are reconnected using
the new configuration. If you select Cancel, you will be returned to the
Customize Communications panel and the values you previously entered
remain as the current values.

6. Select Save or Save As from the File menu to manually save your
configuration.
When you select Save As, the Save Workstation Profile As window
appears. Specify each item and then select OK.

Note

If you select Save on Exit, from the File menu, the changes are
automatically saved to the existing workstation profile each time
you exit this session.
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Chapter 5. Using Sessions

This chapter describes how to start and stop single and multiple sessions.

If your configuration information was saved, as described in “Saving
Configuration Information” on page 44, it is stored in a workstation profile
(*.WS). If you have a session icon, you can double-click it to start a session,
using the saved configuration information.

Note: If you are a first-time user of Personal Communications, or there are no
session icons in your Personal Communications folder, refer to
“Chapter 4. Configuring Sessions” on page 19, to create a configuration.

Starting Sessions

You can use the following methods to start sessions:
v Select an already-configured session icon.
v Start from an existing session window
v Specify a workstation profile name on the OS/2 command prompt. For

example:
C:\PCOMOS2\PCSWS.EXE C:\PCOMOS2\PRIVATE\MY.WS

v Start multiple sessions with a batch file
When you start multiple sessions, the titles of session windows are Session
A, Session B, and so on, unless you’ve customized them.

Starting by Selecting the Session Icon
To start a session, double-click the Session icon. (This icon has the same name
as the workstation profile if you did not specify a name for it.)

The session starts.

Starting from a Session Window
Use the following methods to start from an existing session window:
v Start another session using the same workstation profile
v Start another session using another workstation profile
v Start a different type of session using the same session window

Starting Another Session Using the Same Profile
Select Run the Same from the File menu. Another session starts, using the
same profile.

© Copyright IBM Corp. 1984, 2000 47



Starting Another Session Using a Different Profile
1. Select Run Other from the File menu.

The Open Other Workstation Profile window appears.
2. Double-click the desired workstation profile in the File Name list.
3. Select OK.

Another session starts, using the profile specified in step 2.

Starting a Different Type of Session from a Session Window
v Select Open from the File menu.
v Specify the desired workstation profile and then select OK.

The current session ends and then another session starts, using the selected
profile.

Starting a Workstation Profile from the OS/2 Command Prompt
To start the session, type the following command on the OS/2 command
prompt and then press Enter.

C:\PCOMOS2\PCSWS.EXE C:\PCOMOS2\PRIVATE\MY.WS

The session starts, using the specified workstation profile.

Starting Multiple Sessions

You can use the batch program, which runs batch files (*.BCH), to start two or
more workstation profiles at the same time. Personal Communications batch
files can also start other programs when you include their startup commands.
This is especially useful if you always want to start an application when you
start a session. For example, you might want to start an application, such as
ZipPrint, that uses a Personal Communications API.

If you created an icon for your batch file, you can start workstation profiles
and other programs in the batch file just by double-clicking the icon.

Creating a Batch File
To create a batch file:
1. Double-click the.Multiple Sessions icon.
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The Create/Modify Batch File window appears.

2. There are four methods for including profiles or programs in a batch file.
Use the method you prefer
v Double-click the file names in the File Name list box.
v Drag and drop the file names with the right mouse button from the File

Name box to Batch-File Entries.
v Select a file name from the File Name list box and then select Add.
v Type the complete path and command file name in the edit area.

Personal Communications places the full path and command that is
needed to run the workstation profile or other program above the cursor
line in the edit area. If there is no cursor, the command will be added to
the last line.

To see the contents of the profile you added to the batch file, click it in the
File Name. list box and then click View File or the magnifying glass.

Note

Some brief instructions appear at the top of Batch-File
Entries; you need not remove them because they do not
affect the running of the batch file.
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3. Repeat step 2 on page 49 for each subsequent file to be added.

PCSWS.EXE Options

v To suppress the IBM logo when you start one or more sessions,
add the parameter /Q to the first command in the batch file:
C:\PCOMOS2\PCSWS.EXE C:\PCOMOS2\PRIVATE\TCPIP1.WS /Q

v To start a session as an icon, not as a window, add the parameter
/I to the command in the batch file:
C:\PCOMOS2\PCSWS.EXE C:\PCOMOS2\PRIVATE\TWINAX.WS /I

v To start a session with a specific short session ID, insert the
parameter /S=m after PCSWS.EXE in the batch file:
C:\PCOMOS2\PCSWS.EXE /S=m C:\PCOMOS2\PRIVATE\LAN1.WS

where m is the short session ID.

Note: If you use the /S option to assign A as the short session ID,
you should use this option for all of the sessions in the
batch file. Otherwise, if another session starts first, it
becomes the A Session and the session with the /S=a option
will not start because of the conflicting short session IDs.
Another way to prevent conflicts is to assign a character
later in the alphabet for the short session ID.

4. When you complete the edit, save the created batch file by selecting Save
from the File menu.
The Save Batch File As window appears.

5. Enter a name for the batch file (*.BCH).
The name you enter is used as the icon title, unless you enter a description
as well.

Note

When the file name is used for the icon title, it appears in
uppercase and is restricted to 8 characters.

6. Select OK to continue.
7. Select Yes if you want to create an icon for the batch file.
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A message appears, asking you to save the batch file.
8. Select OK.

The following two examples are of batch files that sequentially run four
workstation profiles, saved in the C:\PCOMOS2\PRIVATE directory, and
then run MYAPP.EXE.

Sample PC/3270 Batch File
C:\PCOMOS2\PCSWS.EXE /S=b C:\PCOMOS2\PRIVATE\COAX1.WS /Q
C:\PCOMOS2\PCSWS.EXE /S=a C:\PCOMOS2\PRIVATE\COAX2.WS /I
C:\PCOMOS2\PCSWS.EXE /S=d C:\PCOMOS2\PRIVATE\SLAN1.WS
C:\PCOMOS2\PCSWS.EXE /S=c C:\PCOMOS2\PRIVATE\SLAN2.WS
C:\APPL\MYAPP.EXE

Sample PC400 Batch File
C:\PCOMOS2\PCSWS.EXE /S=b C:\PCOMOS2\PRIVATE\AS4X1.WS /Q
C:\PCOMOS2\PCSWS.EXE /S=a C:\PCOMOS2\PRIVATE\AS4X1.WS /I
C:\PCOMOS2\PCSWS.EXE /S=d C:\PCOMOS2\PRIVATE\AS4Y1.WS
C:\PCOMOS2\PCSWS.EXE /S=c C:\PCOMOS2\PRIVATE\AS4Y1.WS
C:\APPL\MYAPP.EXE

Using a Batch File
You can use one of the following methods to run a batch file:
v Double-click a batch file icon.
v Run the batch file from an OS/2 command prompt:

[drive]:\[path]\PCSBAT.EXE [drive]:\[path]\xxxx.BCH /R

Note: To run a batch file, specify the /R option.
v Double-click the Multiple Sessions icon.
v Select Open from the File menu in the Create/Modify Batch File window.
v Select the desired batch file and then select OK.

The contents of the batch file appears in the edit area.
v Select Run from the Run menu.

Editing an Existing Batch File
To edit an existing batch file:
1. Double-click the Multiple Sessions icon.

The Create/Modify Batch File window appears.
2. Select Open from the File menu.

The Open Batch File window appears.
3. Select the batch file you want to edit and then select OK.
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The contents of the batch file you selected appear in the edit area of the
Create/Modify Batch File window.

4. Edit the batch file. Refer to step 2 on page 49 for more details.
Refer to the online help for details about the menu bar Edit functions.
Select Index from the Help menu and then select Menu-Bar Commands of
the Batch-Program Window.

5. When you complete the edit, save your changes by selecting Save or Save
As from the File menu.
v Select Save to save your changes in the existing file.
v Select Save As to save your changes in a new file and then continue

with step 5 on page 50
6. Exit the Create/Modify window.

Starting Multiple Sessions without a Batch File
To start multiple sessions without a batch file:
1. Double-click the icon for the session you want to start first.
2. After it connects to the host, select one of the following choices from the

File menu:
v Run the Same... to start another session with the same configuration.
v Run Other... to start a session with a different configuration.

When the Open Other Workstation window appears, select the profile
you want to start and then select OK.

Automatically Starting Sessions

To start one or more sessions automatically when OS/2 starts:
1. Open the OS/2 Startup folder.
2. Drag the session icon or the batch icon to the Startup folder.

Stopping Sessions

To stop a session, double-click the upper left corner of the session window, or
select Exit from the File menu.

To stop multiple sessions at the same time, select Exit All from the File menu.
All sessions end, and the associated session windows are closed.
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Before Stopping a Session

If you perform this operation while a host application program
is running, your session stops and you lose your connection to
the program. Therefore, make sure you exit any host application
programs-the system sign-on panel should appear in the session
window-before you exit the session.

By default, your current configuration information is saved when
you exit the session.
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Chapter 6. Managing Personal Communications Resources

Managing Sessions

Personal Communications provides the following functions, in addition to
those provided by OS/2, for those who work with several open session
windows simultaneously. These functions allow you to manage your session
windows easily and quickly.

Jump Use Jump to switch between the currently opened session windows.

You cannot use Jump to switch to a session window that is currently
hidden. Instead, select Show from the Window menu to display the
session window on the screen. Then, select Jump.

Hide Use Hide to stop displaying a visible session window.

You cannot hide all sessions. At least one session is always shown.

Note: Windows hidden with Hide are not displayed in the OS/2 task
list.

Show Use Show to displaya session window that was previously hidden
with Hide.

View Use View to display a previously-saved arrangement of windows, or
to save an arrangement of windows.

Personal Communications can save and restore the following
information relating to the session window view:
v Position and size of each window
v Window status (standard, minimized, or maximized)
v Window font

You can save view information for up to eight windows.

Managing Access Feature Resources

Subsystem Management is an online facility that monitors and controls the
communications resources of Access Feature. This allows you to adjust these
resources to improve the efficiency of SNA communication services or to
monitor and test these services during problem determination. The changes
that you make while using Subsystem Management are not permanent and do
not affect the configuration file.
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Note:Refer to the Personal Communications Reference for more information on
subsystem management.

Getting Help

For more information about managing session windows, refer to the online
help:
1. Select Procedures from the Help menu.
2. When the help window appears, search for managing or scroll down to

Managing Workstation Windows.
Select choices from that list for detailed information.
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Chapter 7. Printing

You can use Personal Communications to print from display or printer
sessions.

From display sessions, you can print all (Print Screen) or part (Trim
Print) of the screen of your session window on a workstation printer.

To print only part of the session window, drag the mouse to create a
trimming rectangle around the part of the window you want to print
and then select Print Screen from the File menu.

From printer sessions, you can direct printing from an S/390, AS/400,
or S/3X system to a workstation printer.

Configure a printer session to designate a workstation printer as a
system printer that will use either the printer definition tables (PDTs)
provided with Personal Communications or the OS/2 printer drivers.
v Use PDT files for Personal Communications to print files based on

printer control information, such as control codes and the printer
output format, defined in the PDT.

v Use OS/2 printer drivers for Personal Communications to print files
based on printer setup parameters, such as scaling, duplex options,
and page orientation, that you define in Printer Setup.

When you configure a printer session, refer to the online help for
detailed information for each parameter.

For more information about printing, refer to Personal Communications
Reference or the online Information Notebook.
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Chapter 8. Editing

You can edit the contents of your session window using the OS/2 clipboard
and the Edit menu. You can also link the session window with an OS/2 or a
Windows application program by running CopyLink and PasteLink.

Note: The command you should use for PasteLink depends on the
application program you are using.

Editing by Linking to OS/2 or Windows Application Programs

Linking to OS/2 or Windows application programs supporting PasteLink lets
you paste session-window data to the windows of those application
programs. You can run CopyLink when DDE/EHLLAPI is usable.

Confirming the DDE/EHLLAPI Settings
To check whether DDE/HLLAPI is currently set to usable status:
1. Select API Settings from the File menu.

The API Settings window appears.
2. Make sure the DDE/EHLLAPI check box is selected.

If the box is checked, DDE/EHLLAPI is set to usable status. Continue to
step 4.

3. If the box is not checked:
a. Click the DDE/EHLLAPI check box and then click OK.
b. Stop and then start your session to enable the new settings.

4. If DDE/EHLLAPI was already set to usable status, select OK.

Using CopyLink and PasteLink
To use CopyLink and PasteLink:
1. Mark the session window area for which CopyLink should be issued.
2. Select CopyLink from the Edit menu.

If the session window is already linked with an OS/2 or Windows
application program, CopyLink appears in gray and cannot be selected. In
this case, force the application program to end the linkage, or stop the
application program. Then you can select CopyLink.

3. Start the OS/2 or Windows application program for the window to which
an area should be copied.

4. Specify the location for which PasteLink should be run.
5. Issue PasteLink by using the menu for the application program.
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The contents of the marked area are pasted into the specified location in
the window of the application program.
CopyLink is now completed.
When the contents of the marked area in the session window are updated
during linking, the contents of the area pasted to the window of the linked
application program are also updated.

Copying Table Data to a Spreadsheet

You can use the Cut, Copy, CopyLink, or CopyAppend choices in the Edit
menu to copy data in the session window to the window of an OS/2 or
Windows spreadsheet application program.

To use Copy, select the Paste or PasteLink choice in the application program
window into which data is to be copied.

Data in the marked area can be copied in the following three data formats,
depending on the format supported by the spreadsheet for the window to
which data is to be copied:

Sylk format
Data format for general-purpose spreadsheets, such as Multiplan**

Biff3 format
Data format for Microsoft** Excel**

Wk3 format
Data format for Lotus** 1-2-3**

Note: Whether application programs, such as Excel or Lotus 1-2-3, also
support these data formats in subsequent versions depends on
individual application program specifications.

Individual items of data in tables of the session window are divided
automatically such that they are suitable for spreadsheets, and they are copied
into individual cells of tables in the application program.

Copying Marked Data without Dividing It into Cells
To paste data in the marked area per line, without dividing it into individual
cells, add the following lines to the workstation profile:
[Edit]
Sylk=N (If Sylk format data is not divided into cells)
Biff3=N (If Biff3 format data is not divided into cells)
Wk3=N (If Wk3 format data is not divided into cells)
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Copying Lines Containing Only Operational Signs
If data in the marked area contains signs, such as +, -, =, or |, the signs are
regarded as being ruled lines of the table. Once they are removed, only
numeric data is copied.

To copy these signs without replacing them with null characters, add the
following lines to the workstation profile:
[Edit]
MaskGridCharacter=N

Copying Data in Cells As Text Data
Data in the marked area is treated as numeric data by default. Therefore,
currency signs, such as $, and punctuation marks, such as commas, are
removed before copying. To copy data containing such signs and marks as
text data rather than numeric data, add the following lines to the workstation
profile:
[Edit]
ConvertToNumeric=N

Data in the marked area containing signs and marks is then copied as text
data. In addition, all numeric data that does not contain signs and marks is
also copied as text data.

Getting Help

For information about all the tasks you can perform with the Edit menu
choices, as well as how to mark and then edit an area within the window,
refer to the online help:
1. Select Index from the Help menu.
2. When the help window displays, select Menu Bar Commands of the

Workstation Window.
3. Select Edit from the list of Menu Bar Commands.
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Chapter 9. Transferring Files

Personal Communications File Transfer enables the transfer of one or more
files between a host system and workstation. You can define file transfer
options in advance to help you transfer a variety of files quickly and easily.

File Transfer is quite different from the PC400 function, Data Transfer, which
is described in “Chapter 12. Data Transfer (PC400 Only)” on page 75 . The
main differences are listed here:

Type of
Transfer

Products
required on an
AS/400 system

Access Method Sending and
receiving unit

Type of
connection to
an AS/400
system

File Transfer Personal
Communications
Tools
(APVAFILE)

Transfer menu
in session
window

Entire file Display session

Data Transfer PC
Support/400
V2R2 or V2R3
or OS/400
V3R1 or later¹

Data Transfer
icon

Field, record, or
file in a
database

Router session

¹ OS/400 provides the host transaction program for Data Transfer.

With Personal Communications, you can perform the following file transfer
functions:

Send files to the host system
Send files using the Transfer menu or, from 3270 sessions, the SEND
command from an OS/2 command prompt.

Receive files from the host system
Receive files using the Transfer menu or, from 3270 sessions, the
RECEIVE command from an OS/2 command prompt.

Create, test, replace, and delete templates
Create a template to have Personal Communications automatically
generate a workstation or host file name and transfer type when you
select a file to be sent or received.

Define transfer types
Define up to 16 transfer types for each host system. Text, binary, and
append (except for CICS) are initially set as transfer types.
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Select, create, and customize translation tables
Select translation tables to define which translation table is used
during file transfer.

Import or export files (PC/3270 only)
Import/Export is an office system communication program and an
application program run on the IBM Customer Information Control
System (CICS). The import/export function makes it possible to
import or export Final Form Text (FFT), Revisable Form Text (RFT),
and PC documents.

When you export a file from the host, your workstation receives the
file you exported and an interchange document profile (IDP) file.
Before you can import a file to your workstation, you need to create
an IDP file with transmission information.

Create interactive document profile (IDP) files (PC/3270 only)
An IDP file contains document header information, has the same
name as the file to be transferred, and has the extension .IDP.

To create an IDP file, select Setup from the Transfer menu.
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Host Requirements
Before you can send or receive files one of the following file transfer
programs must be installed on the host system.

For 3270 session SBCS mode File Transfer, you need one or more of the
following host file transfer programs, commonly referred to as
IND$FILE:
v IBM 3270-PC File Transfer Program, 5665-311 (MVS/TSO)
v IBM 3270-PC File Transfer Program, 5664-281 (VM/SP)
v IBM 3270-PC File Transfer Program, 5798-DQH (CICS/MVS)

For 3270 session DBCS mode File Transfer, you need one or more of the
following host file transfer programs, commonly referred to as
APVUFILE:
v VM/CMS File Transfer Program, 5799-PGX, 5799-BWK (in Japan)
v MVS/TSO File Transfer Program, 5799-PGY, 5799-BWJ (in Japan)
v CICS (MVS, VSE) File Transfer Program, 5799-PGZ, 5799-BWL (in

Japan)

For 5250 session SBCS mode File Transfer, you need the following host
file transfer program, commonly referred to as APVAFILE:
v Personal Communications Tools Program Package (APVAFILE)

– 1/4-inch tape 85G9969
– 1/2-inch tape 85G9973
– 8-mm tape 46H8353

For 5250 session DBCS mode File Transfer, you need one of the
following host file transfer programs:
v Personal Communications Tools for OS/400, 5799-FPZ
v Personal Communications Tools/400, 5799-QBX (in Japan)

Getting Help

For more information about transferring files, refer to the online help:
1. Select Procedures from the Help menu.
2. When the help window displays, search for transfer or scroll down to

Transferring Files.
3. Select choices from that list for detailed information.
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Chapter 10. Setting Up a Session Window’s Appearance

You can use the following functions from the Appearance menu to define the
appearance of your session window:

Display Setup
Customize a variety of characteristics, such as the cursor, pointer, rule
line, and trimming styles, graphics, sound, DBCS, and color palette, in
the display session.

Color Mapping
Set the colors used in session windows.

Font Choose the font to use for display session windows, the style, and
whether it will be an automatic sizing font or a fixed size font. If you
use a fixed size font, you can also choose its size. The set of fonts
from which you can choose depends on the type of display you are
using.

Note: You cannot change the font size when the session window is
maximized.

Window Setup
Change the appearance and title of the session window and change
the session icon.

Tool Bar
Add, delete, move, copy, and rearrange buttons on the tool bar. You
can also add or delete titles and borders for each tool bar item.

The settings are stored in a workstation profile.

Tool Bar Setup

The tool bar displays under the menu bar in your session window to allow
quick access to the Personal Communications functions, commands, and
defined macros.

If you used USER1.MAC, USER2.MAC, or USER3.MAC in Version 4.0,
Personal Communications automatically adds icons for them on the tool bar.
Otherwise, the default tool bar does not contain icons for macros.

© Copyright IBM Corp. 1984, 2000 67



Use the tool bar pop-up menu to quickly and easily create, edit, and delete
tool bar items, as well as to save and load customized tool bars. When you
customize the tool bar, you can change the order of items, add and delete
items, change the function, title, or graphic associated with any item, change
the fonts, colors, and other tool bar visual style elements.

To customize your tool bar, select Tool Bar from the Appearance menu, or
display the Tool Bar pop-up menu by clicking on the right mouse button
while pointing at any part of the tool bar.

For information about customizing the tool bar, refer to the online help from
the Tool Bar Setup window.

If you want to hide the tool bar, refer to “Showing or Hiding the Menu Bar
and Tool Bar”.

Showing or Hiding the Menu Bar and Tool Bar

You can show or hide the menu bar or tool bar. To do this:
1. Click the top-left corner of the session window to display the system

menu.
v Hide Menu Bar appears when the menu bar is shown
v Show Menu Bar appears when the menu bar is not shown
v Hide Tool Bar appears when the tool bar is shown
v Show Tool Bar appears when the tool bar is not shown

2. To hide either the menu bar or tool bar, select Hide Menu Bar or Hide
Tool Bar.

3. To show either the menu bar or tool bar, select Show Menu Bar or Show
Tool Bar.
If you hide the menu bar, the Popup Menu Bar choice is added to the
system menu. The Popup Menu Bar shows a cascading menu that contains
all commands in the hidden menu bar.

Getting Help

If you’re not sure how to set the session window’s appearance options, view
the detailed instructions in the help.
1. Select Procedures from the Help menu.
2. When the help window appears, search for appearance or scroll down to

Changing the Screen Appearance.
Select choices from that list for detailed information.
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Chapter 11. Setting Up and Using the Assist Functions

Personal Communications provides auxiliary functions that help you perform
tasks in your display sessions more efficiently. Select these functions from the
Assist menu of the session window.
v Keyboard/Macro functions
v Hotspots setup
v Keyboard setup
v Pop-Up keypad setup
v Mouse setup
v Macro functions
v Browser setup

Keyboard/Macro Functions

A Keyboard/Macro Function lets you play macros or use Personal
Communications-supplied key functions without using the keyboard. Run the
macros or key functions from the current cursor position in the session
window.

Key Functions
Personal Communications provides many key functions that can be assigned
to the keys on the keyboard, the mouse buttons, or the buttons of the pop-up
keypad. You can also use them in macros.

Hotspots Setup

A hotspot is an area of the session window on which you can double-click the
left mouse button to perform a command or function. You do not need to use
the keyboard. For example, you can double-click a PF key number to perform
the PF key function.

3D Hotspots

Select Show hotspots to get 3D hotspots; these only require a
single click, and they stand out on your screen.
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You can define the following actions for a hotspot:
v Connect to a Web site by clicking on a URL that appears on the screen
v Simulate function keys
v Play a macro that has the same name as the character string you select on

the session window
v Enter the selected string at the cursor position
v Simulate the Enter key at the cursor position

Using Hotspots

Note

You must have a mouse to use hotspots.

To use a hotspot:
1. Move the mouse pointer to the hotspot displayed in the session window.
2. Double-click the left button of the mouse, except for 3D hotspots, which

only require a single click.
Personal Communications determines whether you have specified a
hotspot function that matches what appears at the position of the mouse
pointer. If so, it processes the hotspot. When two or more hotspots are
specified for a single character string, the first retrieved hotspot is processed.
Hotspots are retrieved in the following order:

(1) Point-and-select (connect to Web site using URL)
(2) PFnn, FPnn, Fnn, nn
(3) Point-and-select (run the macro)
(4) Point-and-select (enter the selected string)
(5) Point-and-select (enter at the cursor position)

Keyboard Setup

You can use Keyboard Setup to modify the functions defined for each key on
the keyboard.

You can define what each shift state of a key does; it can:
v Perform a key function
v Play a macro
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v Enter characters

To change your keyboard setup:
1. Select Keyboard Setup from the Assist menu.

The Keyboard Setup window appears.
2. Select Customize.
3. When the Customize Keyboard window appears, change the key functions

as you desire, referring to the online help for detailed instructions.
4. Save the new keyboard layout in a keyboard file (.KMP).

Note

Assigning a function to the PrintScreen key
If you redefine the PrintScreen key, you must disable that key in
OS/2 System Setup. Otherwise, the new function will not work.

Assigning the Enter/Ctrl and Reset/Ctrl keys
If you redefine the Enter/Ctrl or Reset/Ctrl keys to another key,
neither of the original functions will work correctly.

Note: For a list of the default key assignments, refer to “Appendix D.
Default Key Function Assignments” on page 129 .

Pop-Up Keypad Setup

The pop-up keypad is a small window in which some buttons are arranged.
To display the pop-up keypad, press the right mouse button or select the
Assist menu and then select Display Pop-Up Keypad.

Note

You must have a mouse to use the pop-up keypad.

You can allocate the following functions to the buttons:
v A standard key function provided by Personal Communications
v A macro that you have created
v A character string

Chapter 11. Setting Up and Using the Assist Functions 71



To perform these functions, you only need to click the pop-up keypad with
the left mouse button.

To view the description of each short-name key function or each macro name,
click the right mouse button.

Pop-Up Keypad File
You can change the functions, colors, and size of the pop-up keypad. You can
assign macros, functions, and characters to the keypads. You can save keypad
attributes, such as the number of pads, number of buttons, functions, and
colors in a file (*.PMP). You can define which pop-up keypad file is allocated
to the pop-up keypad.

Using the Popup Keypad
To use a pop-up keypad:
1. With the mouse pointer anywhere in the session window, click the right

mouse button. Or select Display Popup Keypad from the Assist menu.
2. Select Pad 1, Pad 2, Pad 3 or Pad 4.
3. Click the required button in the pop-up keypad.

Mouse Setup

The Mouse Setup lets you allocate functions to the right and left buttons of
the mouse; this enables you to perform the following actions without having
to use the keyboard:
v Performing a key function
v Playing a macro
v Placing a character at the current cursor position

Mouse File
You can save the functions defined for the mouse buttons in a mouse file
(*.MMP). You can create one or more mouse files and switch between them as
required.

Macro Setup

A macro is a sequence of actions and host commands that you can perform
with a single command. You can edit an existing macro or create a new macro
by selecting Macro Setup from the Assist menu.

Using a Macro
You can use a macro in various ways. Table 3 on page 73 lists examples of
how you can set up and then use macros.
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Table 3. Macro Use Examples and Settings

If you want to... Do this...

Automatically play a macro when your
workstation starts.

Set an automatic start macro.

Play a macro during attachment to a host
application.

Start Macro play.

Play a macro with the keyboard or macro
function.

Use the Keyboard/Macro Function.

Double-click a hotspot to play a macro. Set up a Hotspot.

Select a button from the pop-up keypad
to play a macro.

Set up the Pop-Up Keypad.

Press the mouse button to play a macro. Customize a Mouse file.

Press a key on the keyboard to play a
macro.

Customize a Keyboard file.

Creating a Macro
To create a macro:
1. Select Macro Setup from the Assist menu.
2. When the Macro Setup window appears, select Customize.
3. When the Customize Macro window appears, edit the macro. You can

enter macro statements directly or select a macro from the list of key
actions.
Refer to the online help for detailed information.

4. Save the macro file and then select OK.

Macro Statements
You can use the following macro statements when you create a macro:

Key function
Any of the key functions provided

Macro Edit an existing macro or create a new macro; you can nest up to 16
macros.

Character
Any character or string that you type or select.

Character string
Any character strings that you type or select.

Wait condition
Cause the macro to stop for various reasons that you can specify, such
as the time or appearance of something in the session window.
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Tokens
Commands, such as GOTO and RUN to add logic.

SEND/RECEIVE
Initiate a file transfer to or from the host system.

Web Browser Setup

Web Browser Setup allows you to select the application that you would like to
use to view URLs. If you know the path and filename of the web browser or
other viewer that you would like to use, type it in the entry field provided.
Otherwise, click on browse to select the application. The selected web browser
can then be launched by clicking on a URL hotspot.

Getting Help

For information on how to set up and use the Assist functions:
v Select Procedures from the Help menu.
v When the help window appears, search for assist or scroll down to Using

the Assist Functions.
Select choices from that list for detailed information.
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Chapter 12. Data Transfer (PC400 Only)

PC400 Data Transfer enables you to transfer data between an AS/400 system
and your workstation. To use the Data Transfer function, double-click the
Data Transfer icon.

Transferring data is quite different from transferring files, which is described
in “Chapter 9. Transferring Files” on page 63.

Requirements

Before you can transfer data with PC400:
v You must have a router session, unless you have an APPC

connection via CM/2 or OS/2 Access Feature.
v IBM PC Support/400 (5738-PC1) must be installed on your

AS/400 system, unless IBM OS/400 Version 3 or later is
installed.

There are two types of data transfer, depending on the direction of the
transfer.

Data sending
Data is transferred from your workstation to the AS/400 system. You
can transfer data to any of the following destinations:
v Existing members in an existing AS/400 physical file
v New members in an existing AS/400 physical file
v New members in a new AS/400 physical file

Note: You cannot transfer data from a workstation file to an AS/400
logical file.

Data receiving
Data is transferred from the AS/400 system to your workstation.

While receiving data from the host, you can specify the data to be
received and where the data is to be output.

Receivable data includes:
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v An entire AS/400 file
v Part of an AS/400 file
v Data combined from several AS/400 files
v Summary of record groups

Specify the following output destinations:
v Display
v Disk
v Printer

Also, you can specify when to receive data (date and time) and the
numeric value format.

For more information about data transfer, refer to the Personal Communications
Reference.
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Chapter 13. Shared Folders (PC400 Only)

The AS/400 system uses a structure called a folder to store and organize text
documents, mail, and other related objects. Personal Communications lets you
share these folders and store both AS/400 documents and your workstation
files in them.

The Shared Folder function lets you access a folder on the AS/400 system as
if it were a drive on your workstation. You can assign up to 8 folders at a
time. For example, a folder on the AS/400 system could be assigned to drive
E on your workstation; you could then access drive E the same way as you
access drive C on your hard drive.

You can use the Shared Folders function to:
v Take advantage of the additional AS/400 storage
v Use AS/400 security to limit access to workstation files
v Share data with multiple users at the same time
v Back up workstation files to an AS/400 folder
v Use OS/2 commands or AS/400 functions to work with workstation files

Requirements
Before you can use the Shared Folders function one of the following
programs must have been installed on the AS/400 system:
v Client Access/400 (or OS/400 V3 or later)
v PC Support/400 (5738-PC1)

Starting Shared Folders

To start using Shared Folders:
1. Double-click the Shared Folders icon in the Personal Communications

folder.

Note: If the IFS driver is not installed, a message asks if you want to
install it now. If you do, select OK and then shut down and restart
your workstation.

The Configure Shared Folders window appears.
2. Select a Drive to be assigned to an AS/400 shared folder.
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3. Select the System Name of the AS/400 containing the shared folder you
want to use.

4. Select the Folder Name you want to use.

Note: If you want to assign a drive to a lower-level folder, double-click on
its upper-level folder from the Folder Name list. The lower-level
folders in the selected folder appear in the Folder Name list.

5. Select Assign.
The specified contents are displayed in the Current Status box.
You can now work with the contents of a shared folder through the
assigned drive.
If you want to keep the same settings for the shared folders each time you
use them, you can save them by doing either of the following steps:

6. Select Save Current Assignments on Exit from the File menu.
The current settings are saved when you exit the Shared Folders function.

7. Select Save from the File menu.

The current settings are saved in the Shared Folder profile (PCSFLR.INI).

Releasing Drives

To release assigned drives:
1. Select the drive name you want to release from the Current Status box in

the Configure Shared Folders window.
2. Select Release.

The specified drive disappears from the Current Status box.

Considerations and Restrictions

This section describes Shared Folders considerations and command
restrictions.

LAN and Switched Line Attachments
When you use a LAN, SNA-over-Async, Hayes** AutoSync, or switched
SDLC attachment, you need to modify the controller device description to
avoid automatic disconnection of the switched line.

To modify the control device description:
1. Enter CHGCTLAPPC on the AS/400 command line.
2. Specify the controller description name for the corresponding router

session.
The Change Controller Description (APPC) panel appears.
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Change Ctl Desc (APPC) (CHGCTLAPPC)

Type choices, press Enter.

Controller description . . . . . > AKI85 Name
Online at IPL . . . . . . . . . *NO *SAME *YES, *NO
APPN-capable . . . . . . . . . . *YES *SAME *YES, *NO
Switched line list . . . . . . . TRNLINE Name, *SAME

+ for more values
Character code . . . . . . . . . *EBCDIC *SAME, *EBCDIC, *ASCII
Maximum frame size . . . . . . . 16393 265-16393, 256, 265, 512...
Remote network identifier . . . APPN Name, *SAME, *NETATR...
Remote control point . . . . . . AKI85 Name, *SAME, *NONE, *ANY
SSCP identifier . . . . . . . . *SAME 000000000001-FFFFFFFFFFFF...
Initial connection . . . . . . . *DIAL *SAME, *ANS, *DIAL
Dial initiation . . . . . . . . *LINKTYPE *SAME, *LINKTYPE, *IMMED...
Switched disconnect . . . . . . *NO *SAME, *YES, *DIAL
Disconnect timer:

Minimum connect timer . . . . 170 0-65535 seconds
Disconnection delay timer . . 0 0-65535 seconds

More...
F3=Exit F4=Prompt F5=Reshow F12= Cancel F13=How to use this display
F24=More keys

3. Type *NO in the Switched disconnect field and then press Enter.
The following panel appears.

Change Ctl Desc (APPC) (CHGCTLAPPC)

Type choices, press Enter.

APPN minimum switched status . . VRYONPND *SAME, VRYONPND, *VRYON
Autodelete device . . . . . . . 1440 1-10000, *NO, *SAME
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND, *SAME
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND, *SAME
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND, *SAME
Restore limits:

Count limit . . . . . . . . . 2 0-99, *SAME, *SYSVAL
Time interval . . . . . . . . 5 0-120 (minute)

Model controller description . . *NO *SAME, *YES, *NO
Connection network network ID . *SAME Name, *SAME, *NETATR, *NONE
Connection network CP . . . . . > *SAME Name, *SAME, *NONE
Control owner . . . . . . . . . *USER *SAME, *USER
Text 'description' . . . . . . . 'AUTOMATICALLY CREATED BY QLUS'

Bottom
F3=Exit F4=Prompt F5=Reshow F12= Cancel F13=How to use this display
F24=More keys

4. Type *USER in the Control owner field and then press Enter.

Commands You Cannot Use
There are some commands that you cannot use when working with folders;
for example:

CHKDSK FDISK RECOVER
DISKCOMP FORMAT SUBST
DISKCOPY JOIN
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When you are using Shared Folders, you cannot use workstation applications
that do direct sector input/output to your hard disk.

Commands with Restrictions
The following commands have restrictions when working with shared folders.

BACKUP
If two drives are assigned to the same folder, do not attempt to back
up the folder from one drive to the other.

BREAK
BREAK must be enabled (BREAK=ON) for the Ctrl+Break sequence to
work properly with a shared-folders operation.

COMP
When you use the COMP command to compare multiple files and the
target file is in a folder, the shared folder is not closed until the
COMP program completes.

COPY, XCOPY
Files cannot be copied to the root directory of a folder name.

EAUTIL
Two options are restricted.
v You cannot use the /J option to join extended attributes to an object

in a folder.
v When you use the /S option to split extended attributes from an

object in a folder, the size of the extended attributes in the object is
not set to zero, because the AS/400 system retains the part of the
extended attributes that includes the document-library object
information.

To avoid these restrictions, copy the object to your hard drive and run
the EAUTIL command from there.

80 Personal Communications Quick Beginnings



Chapter 14. PC Organizer (PC400 Only)

You can use the PC Organizer to run OS/2 commands and applications, DOS
commands and applications, or Windows applications from a 5250 display
session.

AS/400 Requirements
Before you can use the PC Organizer, one of the following programs
must have been installed on the AS/400 system:
v Client Access/400 (or OS/400 V3 or later)
v PC Support/400 (5738-PC1)

Starting the PC Organizer

To start the PC Organizer:
1. Start a 5250 display session.
2. Sign on to the AS/400 system.
3. Enter the following command on the AS/400 command line:

STRPCO PCTA(*NO)

Note

PC400 does not support the PC Text Assist (PCTA) function,
so you should specify this parameter with *NO. Even if you
specify *YES, you cannot use the PC Text Assist function
provided by the PC Support/400 Workstation Feature.

You can now use the PC Organizer functions in a 5250 display session by
using one of the following methods:
v Display and then select choices from the menu.

To display the PC Support/400 or Client Access/400 Organizer menu,
enter:
GO PCOMNU
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v Enter PC Organizer commands.
To start the PC Organizer functions, enter:
STRPCCMD

PCO.EXE Message
When you run a workstation command, program, or DisplayWrite 5/2,
you might receive a message that the PCO.EXE program is not active.
You can ignore this message, because it is not necessary for PC400 to
activate PCO.EXE

Getting Help

Refer to the online help for more information about using the PC Organizer.
1. Select Procedures from the Help menu.
2. When the help window appears, search for organizer or scroll down to

PC Organizer (5250 Session).
Select topics in the list to view information about starting and using the
PC Organizer, using the PC Organizer menu, and the differences between
the PC Organizer provided with PC400 and PC Support/400.
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Chapter 15. Text Assist (PC400 and SBCS Only)

With Personal Communications, you can use the improved text editing
capability of Text Assist provided by the OfficeVision/400 word processing
function to create a document or short messages, or to edit an existing
document.

For more information about using Text Assist, refer to the documents for the
OfficeVision/400 program.

The Text Assist function in Personal Communications is a ″Controller Text
Assist,″ not the ″PC Text Assist″ supported by PC Support/400 Workstation
Feature.

Controller Text Assist in Personal Communications provides the following
functions that are not included in PC Text Assist:
v Line commands
v 132 columns

Controller Text Assist in Personal Communications does not, however, provide
the multicolumn edit function that is included in PC Text Assist.

After starting a 5250 display session, you can use the Controller Text Assist
function without invoking the Start PC Organizer (STRPCO) command at the
host.

Note: In the Text Assist environment, Alt key functions are assigned to the
Ctrl key state to avoid conflicts with existing emulator functions. For
example, the Word Underscore (WrdUnd) key is Ctrl+W rather than
Alt+ W. Many of these functions can be remapped to the Alt key state
without conflicting with emulator functions.

When you draw a line using the cursor draw option of the OfficeVision/400
program, the insert mode is not available.

© Copyright IBM Corp. 1984, 2000 83



AS/400 Software Requirements
The AS/400 system must have one of the following programs installed
to support the Text Assist features:
v OS/400 V2R2.0 with cumulative PTF C3285220 with PTF SF14687
v OS/400 V2R3.0 with PTF SF14495
v OS/400 V3R0.5
v OS/400 V3R1.0, or later

Text Assist Key Functions

Following is a list of OfficeVision/400 Text Assist key functions:

Function Description

Begin of Line Moves the cursor to the beginning of the
line

Begin Bold Begins bold highlighting

Bottom of Page Moves the cursor to the bottom of the
page

Carrier Return Ends a line of text or a paragraph by
inserting a carrier return

Center Text Centers a line of text

End of Line Moves the cursor to the end of the line

End of Page Inserts an ″end of page″ character at the
cursor position

End Bold/Underscore Ends bold highlighting and underlining

Half Index Down Begin subscript or end superscript

Half Index Up Begin superscript or end subscript

Insert Symbol Displays a menu for special symbols

Display Text Codes Shows hidden text controls

Next Column Inserts a ″next column″ instruction at the
cursor position.

Next Stop Code Moves the cursor to the next stop code
symbol

Required Backspace Moves the cursor one space to the left

Required Space Inserts a required space to keep words
together on a line

Required Tab Indents a block of text
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Function Description

Stop Code Inserts a stop code at the cursor position

Top of Page Moves the cursor to the top of the page

Begin Underscore Begins underlining text

Word Underscore Underlines the word that starts at the
cursor position

Getting Help

Refer to the online help for more information about the Text Assist functions:
1. Select Keyboard from the Help menu.
2. Select Search and then type text assist in the Search for field.
3. Select the All sections radio button and then select Search.

Select from the list of Text Assist key functions in the Search window for
more information.
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Chapter 16. Where to Find More Information

This chapter discusses getting help when you are installing, configuring, or
using Personal Communications.

Online Help

This help facility describes how to install, configure, and use Personal
Communications. Online help is very extensive and includes information
about every aspect of configuring and using Personal Communications.

Use help to obtain the following information:
v Menu choices
v Operation procedures
v Operations in windows
v Meanings of the terms displayed in windows
v Causes of errors and the corresponding actions to take
v Mouse-based operations
v Operation without a mouse
v Detailed explanations of specific terms
v Further technical information about Personal Communications
v Detailed explanations of operator information area (OIA) messages

How to Use Online Help
To display online help, select choices from the Help menu.

You can use Personal Communications online help just as you use the online
help for OS/2. Refer to IBM OS/2 information for details.

Messages

This section describes the Personal Communications OIA messages. Online
messages are displayed during Personal Communications sessions but a
message does not always mean an error occurred. For example, a message
might tell you that an operation is in progress or has been completed. A
message can also prompt you to wait for the completion of an operation.

Detailed descriptions of the Personal Communications messages are available
in the Personal Communications Reference.
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Security-Related Messages
Personal Communications optionally utilizes Secure Sockets Layer (SSL) to
establish sessions with servers; this may require input from you (for example,
a password). Refer to Personal Communications Reference for details.

OIA Messages
Personal Communications displays messages in the operator information area
(OIA) or in a pop-up window. Messages from Personal Communications are
displayed in the message window; messages from the host system are
displayed in the OIA of the session window.

The bottom line of the session window is the OIA. The OIA indicator
indicates the status of Personal Communications as well as information about
the workstation, host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online
help. To view this information:
1. Select Index from the Help menu.
2. Select The operator information area messages.

Hint

To look up a specific OIA message, select Search. When the
Search window appears, type the message number in the
Search for field and then select OK.

Personal Communications Library

The Personal Communications for OS/2 library includes the following
publications:
v IBM Personal Communications Quick Beginnings, GC31-8795
v IBM Personal Communications Reference, SC31-8796
v IBM Personal Communications Emulator Programming, SC31-8660

Note: These books are optionally installed.

In addition to the printed books, there are HTML documents provided with
Personal Communications:
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Host Access Class Library
This HTML document describes how to write an ActiveX/OLE
2.0–compliant application to use Personal Communications as an
embedded object.

Host Access Beans for Java
This HTML document describes Personal Communications emulator
functions delivered as a set of Java™ Beans.

Related Publications

For information about local area networks (LANs), refer to the following
publications:
v IBM Local Area Network Technical Reference

v AS/400 Communications: Local Area Network (LAN) Guide Version 2

v Multiple Protocol Transport Services manuals

For information about TCP/IP, refer to the manual for IBM TCP/IP Version 2.0
for OS/2 Base Kit.

For more information about NetWare, refer to the publications for the
following products:

For Client NetWare Client for OS/2

For NetWare for SAA NetWare for SAA

For more information about PC Support/400 refer to the following
publications:
v PC/Support/400: OS/2 Installation and Administration Guide

v PC/Support/400: OS/2 User’s Guide

v PC/Support/400: Application Program Interface Reference

v PC/Support/400: DOS and OS/2 Technical Reference

For more information about the AS/400 system, refer to:
v AS/400 Distributed Data Management User’s Guide

v AS/400 NLS Planning Guide

v AS/400 Programming: Control Language (CL) Reference Guide Version 2

v AS/400 Guide to Programming for Printing

For more information about the mouse, refer to the Mouse Driver User’s Guide
(OS/2).

For more information about OS/2, refer to:
v The User’s Guide to OS/2 Warp

v Using OS/2, a tutorial

Chapter 16. Where to Find More Information 89



v Online books in the Information folder on your desktop.

For the operation of the workstation, refer to your workstation manuals.

For the workstation adapter settings, refer to your adapter manuals.

For printer operation information, refer to your printer manuals.

Contacting IBM

This section lists a number of ways you can reach IBM for various reasons.
Depending on the nature of your problem or concern, we will ask you to be
prepared to provide the following information to allow us to serve you better.
For information about the tools available to help with problem analysis, refer
to the Personal Communications Version 4.3 Reference.
v The environment in which the problem occurs:

– Personal Communications configuration
- Personal Communications version and CSD level
- The name of the workstation profile
- The name of the Access Feature Configuration file (if required)

– Workstation configuration
- The machine type and model, the system memory, the video adapter
- The communication adapter you are using
- Other adapters (especially communication adapters) installed
- The printer type and model
- Other devices installed, such as sound cards, modems, or fax machines

– Software configuration
- Windows version and level
- Communication and device-driver version and level
- Other communication programs (such as NetWare, Microsoft SNA

Server, or Microsoft Data Link Control) that are running and using
resources

- Printer driver version and level
– Host configuration

- The upstream host connection and configuration
v Problem analysis information

– Symptoms
– Type of problem
– OIA messages or error messages (if any)
– Key factors related to the problem
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If you have a technical problem, take the time to review and carry out the
actions suggested here. Use your local support personnel before contacting
IBM. You can also check the Hints and Tips on the WWW for more
information. Only persons with in-depth knowledge of the problem should
contact IBM; therefore, support personnel should act as the interface with
IBM.

Support Options
If you determine that you need to contact IBM, you can do any of the
following:
v Access the Personal Communications Web page:

http://www.ibm.com/software/network/pcomm

v To find the phone number for IBM Software Support, U.S. customers can
call 1-800-IBM-4YOU. International customers that have access to the U.S.
″800″ toll free numbers can reach the International Support Center by
calling 1-800-IBM-4YOU and asking to speak with the International Support
Center (ISC) in Atlanta. International customers without access to the U.S.
toll free numbers can call the ISC directly at 770-863-1234. The ISC’s FAX
number is 770-863-3030 and is available 24 hours a day.
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Appendix A. Communication Adapters and Modems

This appendix lists the communication adapters and modems that Personal
Communications supports. It also describes how to install the software so you
can use a PCMCIA adapter card in your workstation.

Note

Personal Communications will continue to provide support for
modems in the marketplace by creating preconfigured modem
initialization strings. If your favorite modem is not listed here,
select a similar one from the list and try that configuration for
your modem. If it doesn’t work, call IBM Service to have your
modem added to the list of modems supported.

Family-1 Communication Adapters

Personal Communications supports the following communication adapters for
workstations with an AT-bus.
v Advanced IBM PC 3278/79 Emulation Adapter (PC/3270 only)
v IBM Enhanced 5250 Display Station Emulation Adapter (PC400 only)
v IBM Multiprotocol Communications Adapter for ISA (SDLC)
v IBM Async/SDLC Communications Adapter (SDLC)
v IBM PC Asynchronous Communications Adapter
v IBM PC AT Serial/Parallel Adapter
v IBM PC 3278/79 Emulation Adapter (PC/3270 only)
v IBM WaveRunner Digital Internal Modem (ISA)
v IBM WindSurfer Communications Adapter (ISA)
v IBM 5250 Adapter
v Attachmate 3270 Adapter (PC/3270 only)
v Attachmate ADVANCE 3270 Adapter (PC/3270 only)
v DCA IRMA 3 Convertible 3270 Adapter (PC/3270 only)
v LAN adapters supported by MPTS
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Family-2 Communication Adapters

Personal Communications supports the following communication adapters for
workstations with a Micro Channel bus.
v IBM Asynchronous/SDLC V.32 Modem/A (MPA card with modem)
v IBM Multiprotocol Adapter IV/A
v IBM PS/2 Multiprotocol Adapter/A
v IBM PS/2 Dual Asynchronous Communication Adapter/A
v IBM S/36/38 Workstation Emulation Adapter/A
v IBM WaveRunner Digital Internal Modem (MCA)
v IBM WindSurfer Communication Adapter (MCA)
v IBM 3270 Connection (PC/3270 only)
v IBM 5250 Emulation Adapter/A
v IBM 5250 Adapter/A
v Attachmate 3270 Adapter (PC/3270 only)
v Attachmate Advance 3270 Adapter/2 (PC/3270 only)
v DCA IRMA 3 Convertible 3270 Adapter (PC/3270 only)
v LAN adapters supported by MPTS

Asynchronous Modems

Personal Communications supports asynchronous modems for Advantis (IIN),
IBM Global Network Connection, SNA over Async, and Home3270
connections.
v IBM 5841 (1200bps)
v IBM 5842 (2400bps)
v IBM 5853 (2400bps)
v IBM 7855 V.32
v IBM ASYNC/SDLC V.32 Modem/A
v IBM Internal Data/FAX (2400bps)
v IBM High Speed Internal Data/FAX
v IBM PCMCIA Data/FAX (2400bps)
v IBM PCMCIA 2400bps Data (Japan version)
v IBM 14.4/14.4 PCMCIA Data/FAX
v IBM Push-Pop Modem (Data/Fax 14.4K) (Japan Only)
v IBM WaveRunner Digital Internal Modem
v IBM WindSurfer 14400 Modem
v APEX PCMCIA PCR - 9696
v APEX PCMCIA PCR - 1414
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v ARN DX-MC2
v AT&T Paradyne PCMCIA 14.4K Data/Fax for Cellular Mode
v AT&T Paradyne PCMCIA 14.4K Data/Fax for Normal Mode
v Com1 MC217
v Communicate PCMCIA 14400 Fax & Data Modem
v Data Race RediCard High Speed PCMCIA Data/Fax modem
v Digicom Systems Eagle
v Gold Card PCMCIA Modem
v Hayes Smartmodem 1200 compatible
v Hayes Smartmodem 2400 compatible
v Hayes Smartmodem** Ultra 9600
v Hayes Smartmodem Ultra 14400
v Hayes Smartmodem Optima 9600
v Hayes Smartmodem Optima 14400
v Hayes Smartmodem Optima 144 for PCMCIA
v Hayes Smartmodem Optima 28800
v Intel SatisFAXtion 400e
v Megahertz PCMCIA XJ1144
v Microcom QX/423 bis
v MultiTech MultiModem MT1432BLK
v MultiTech MultiModem ZDX for Data & Fax
v Nokia NMP V32bis Data/Fax PCMCIA Modem
v Practical Peripheral PM14400FXSA
v Universal Data Systems FasTalk FAX32
v US Robotics Courier HST Dual Standards
v US Robotics Sportster 14.4 External Modem
v US Robotics Courier 28800 External Modem
v Zoom V.32 bis
v Zyxel U1496E Plus

The following asynchronous modems are only for use with SNA over
Async

v AT&T Comsphere 3820
v AT&T DataPort
v Apex Data Internal Modem for TP 350
v Apex Data Internal Modem for TP 700
v Apex Freedom 14/96 Data/Fax Laptop Modem
v Aspen Home and Away Credit Card Modem
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v BocaModem 14.4 V.32bis External Modem
v BocaModem 28.8 V.34 External Modem
v Codex 3260 Modem
v Com1 MC216 PCMCIA Modem
v Complete 14400 TurboModem
v CREATIX LC 144 VF High Speed Modem
v CREATIX LC288 FC High Speed Modem
v Data Race Thinkpad Internal Modem
v Data Race RediCARD Internal Modem
v GVC FM-144V External Fax Modem
v GVC SM-96 External Modem
v Hayes ACCURA96 + FAX96 Modem
v Hayes ACCURA 14400 Modem
v Hayes ACCURA 28800 Modem
v Hayes OPTIMA144 + FAX144 Pocket Modem
v IBM 7851 External Modem
v IBM 7852 010 V.34 Data/Fax Modem
v IBM 7852 013 V.34 Commercial Data/FAX Modem
v IBM PCMCIA 28.8/14.4Kbps Data/Fax Modem
v IBM PS/2 14.4Kbps Data/Fax Modem Adapter
v IBM Personal System/2 2400 Internal Modem
v IBM ISA 28.8Kbps Data/Fax Internal Modem
v IBM ThinkPad mWave Modem
v IBM Wireless Modem for Cellular/CDPD (Land line)
v IBM Wireless Modem for Cellular/CDPD (Cellular line)
v Other mWave Modems
v Intel 14.4EX Modem
v Intel PCFM7600 14.4/14.4 External Modem
v Intel SatisFAXtion Modem/400
v Macronix Fax/Modem
v Megahertz XJ196FM PCMCIA Data/Fax Modem
v Megahertz XJ2144 14.4/14.4kbps PCMCIA Gold Series Fax Modem with

XJACK
v Microcom AX/9624c Modem
v Microcom DeskPorte FAST Modem
v Microcom MicroPorte 4232bis Portable Modem
v Motorola Codex 3220 Plus
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v Motorola Codex 3261 Fast
v Motorola FasTalk 32bx Modem
v Motorola Montana 28.8 Modem/FAX Card
v Motorola UDS FasTalk II Modem
v Motorola UDS V.3229 Modem
v MultiTech 932 Modem
v MultiTech 1432 Modem
v MultiTech 1432Mu Modem
v MultiTech 2834 Series Intelligent Data/Fax Modem
v Practical Peripherals 9600SA Modem
v Practical Peripherals FX PS/2 Internal Modem
v Practical Peripherals MiniTower PC288MT V.34 Modem
v Practical Peripherals PM14400FX PS/2 Internal Modem
v Practical Peripherals PM14400FX Internal Modem
v Practical Peripherals PM14400FX V.32bis Internal Modem
v Practical Peripherals PM1400FX PKT Modem
v Practical Peripherals PM9600FXMT Modem
v Practical Peripherals PM14400FXMT Modem
v Practical Peripherals PM9600MT II Modem
v Practical Peripherals FXSA Modem
v Racal-Datacom ALM3223 Modem
v Racal-Datacom ALM3226 V.32bis Modem
v Rolm 244 PC Telephone
v SupraFAX V.32bis Modem
v Telebit Trailblazer Modem
v US Robotics WorldPort 9600 Modem
v US Robotics WorldPort 14400 Modem
v ViVa 14.4/FAX Modem
v Zenith Data Systems 2000 Laptop Modem
v ZOOM EVFXV32 Modem
v ZOOM EVFXV32 Internal Modem
v ZOOM EVFPV32bis Modem
v ZOOM EVFPV32bis Internal Modem
v ZOOM VFX 28.8 External Modem
v ZyXEL U-1496 Series Universal Modem
v User-Defined Asynchronous Switched Connection Modem
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Asynchronous Modems (Hayes AutoSync)

Personal Communications supports the following Hayes AutoSync-compatible
modems.
v ARN DX-MC2 PCMCIA/Nota
v AT&T Paradyne PCMCIA Modem
v Apex Data Internal Modem for TP 350
v Apex Data Internal Modem for TP 700
v Apex Data PCMCIA Modem
v Com1 MC216 PCMCIA Modem
v Com1 MC217 AutoSync (CBF)
v CREATIX LC 144 VF High Speed Modem
v CREATIX LC 288 FC High Speed Modem
v Hayes OPTIMA 9600
v Hayes OPTIMA 14400
v Hayes OPTIMA 144 + FAX 144 Pocket Modem
v IBM 701 ThinkPad Internal Modem
v IBM 7852 010 V.34 Data/Fax Modem
v IBM 7852 013 V.34 Commercial Data/Fax Modem
v IBM PCMCIA Data/Fax Modem
v IBM PCMCIA High Speed Data/Fax Modem
v IBM PCMCIA 14.4 kbps Data/Fax Modem
v IBM PCMCIA 28.8/14.4 kbps Data/Fax Modem
v IBM PS/2 14.4 kbps Data/Fax Modem Adapter
v IBM ISA 28.8 kbps Data/Fax Internal Modem
v IBM Wireless Modem for Cellular/CDPD (Land line)
v IBM Wireless Modem for Cellular/CDPD (Cellular line)
v Megahertz XJ1144FM PCMCIA Data/Fax Modem
v Megahertz XJ2144 14.4/14.4 kbps PCMCIA Gold Series Fax Modem with

XJACK
v Practical Peripherals PM14400FX PS/2 Internal Modem
v Practical Peripherals PM14400FX V.32 bis Internal Modem
v Practical Peripherals PM9600FXMT Modem
v Practical Peripherals PM14400FXMT Modem
v User-Defined AutoSync Switched Connection Modem
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Synchronous Modems (SDLC)

Personal Communications only supports the bit-oriented (HDLC) toptocol for
V.25 bis call control messages. Modems must support an ASCII-coded
character set consisting of 7-bit characters with odd parity.

PCMCIA Communication Adapters

Personal Communications supports the following PCMCIA communication
adapters.
v IBM 3270 Emulation Credit Card Adapter (PC/3270 only)
v IBM 5250 PCMCIA Adapter Card
v Refer to Async and AutoSync modem lists for PCMCIA modem adapters.
v PCMCIA LAN adapters supported by MPTS.

Installing PCMCIA Support

If your workstation uses PCMCIA cards, the software that enables these cards
to work must be installed on your workstation. This software consists of two
main layers, Socket Services and Card Services, and some device drivers that
are associated with them.

Note:Card Services and Socket Services are provided by OS/2.

The device drivers required depend on the version of OS/2 and the type of
workstation that you have.

For OS/2 Warp:

PCMCIA.SYS
Card Services

IBM2SS01.SYS
Socket Services1

Sequence and Position of the Drivers
The sequence in which the PCMCIA device drivers are loaded is critical;
normally, this will be taken care of by the program that installs them but, if
you have a problem, you should ensure that the sequence is correct.

OS/2 Warp:
BASEDEV=PCMCIA.SYS /P

:
DEVICE=C:\OS2\BOOT\COM.SYS

1. For some IBM computers; similar drivers are provided for others.
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:
BASEDEV=IBM2SS01.SYS /S0=2

:
DEVICE=C:\IBMCOM\MACS\IBMTOKCS.OS2

Personal Communications Device Drivers
Some attachment types need a device driver; when you configure any of these
attachments, Personal Communications installs the appropriate driver. The
driver must be loaded after the PCMCIA device drivers, so the configuration
program adds them (in DEVICE= statements) at the end of CONFIG.SYS:
PCSCOAX.SYS (DFT)
PCSTDLC.SYS (Twinax)

Refer to the Communications Server Command Reference for a list of Access
Feature device drivers.
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Appendix B. Attachment Considerations

This appendix describes factors you should consider when configuring
Personal Communications for the attachment types listed here.

COAX Attachment

This section describes factors you should consider when configuring Personal
Communications with a coaxial attachment.

Avoiding Machine Check 207
Patch the microcode of the 3174 control unit. The following table shows the
relationship between 3174 control unit microcode levels and patch IDs:

Microcode Level
Patch ID

S0503 PCA53D1

S0504 PCA53D2

A0503 PCA53D3

A0504 PCA53D4

B0200 PCA53D5

B0401 PCA53D6

B0402 PCA53D8

C0101 PCA53D7

In addition, if you have a 3174 with Configuration Support B or higher, you
can set the following parameters:
v 3174 customization Q126 digit 2=1 to change the COAX timeout from 50 to

100 microseconds.
v 3174 customization Q125 digit 4=1 to set command chaining off.

Polling Feature
Certain ISA-bus workstations disable interrupt-level 2 (IRQ 9) and reserve it
for their own use. IRQ 9, a redirected IRQ 2, is the only interrupt level that
can be used by the IBM 3278/79 emulation adapter. Sometimes, when you try
to use PC/3270 for coaxial attachment with this type machine, you cannot
connect to a host system.
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If this happens, add the Poll=Y parameter to the [CSDFT], [CNDFT], or [CUT]
(*.WS) as follows:
v SNA/DFT attachment

[CSDFT]
Poll=Y <-- add

v Non SNA/DFT attachment
[CNDFT]
Poll=Y <-- add

v CUT attachment
[CUT]
Poll=Y <-- add

Running PC/3270 on a PS/VP with a Coaxial Attachment
The PS/VP system unit uses IRQ 9 for AT applications that use video retrace;
IRQ 9 conflicts with the IBM 3278/79 emulation adapter. To use the 3278/79
emulation adapter, remove a jumper (the function of which is ″Video Interrupt
(IRQ9) enable″), from the system board. The jumper varies according to the
model of PS/VP, here are some examples:

PS/VP 6381 /Si 425SX and 433SX : Jumper J23
PS/VP 6381 /Si 433DX and 466DX2 : Jumper J14

Ask your IBM dealer for information about other models.

Also, you can use the PC/3270 Coax Polling feature described on page
“Polling Feature” on page 101 .

Functions Not Available with CUT Attachment
When the workstation is configured by CUT attachment, the following
functions cannot be used:
v File transfer
v API (DDE,EHLLAPI,SRPI) function
v Host graphic function
v Edit functions, except for copy and copy append
v Host print function

Controller Language for CUT Attachment
Only American English and Austrian/German are supported as the controller
language. The controller language can be retrieved by controller customization
question number 121.

PCMCIA Configuration for a DFT or CUT Attachment
If your workstation has an IBM 3270 Emulation Credit Card Adapter (3270
CCA) installed, Personal Communications uses it in the same way as the IBM
3278/79 Emulation or 3270 Connection Adapter, but configuration of the card
and of the 3270 sessions is more complicated. When you use 3270 CCA with a
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token-ring credit card adapter, you must change the interrupt level of the
token-ring card through the IBM LAN Adapter and Protocol Support (LAPS)
configuration. PCMCIA support must be loaded by the OS/2 Install Program
before you use the IBM 3270 CCA adapter to connect.

LAN via IEEE 802.2 Attachment

Following is a description of preinstallation considerations for installing
Personal Communications for use on a LAN. Refer to MPTS and LAN adapter
documentation for detailed information on installing and configuring 802.2
support for the adapter.

Maximum I-Field (PIU) Size
This value is negotiated between your workstation and the host system,
unless XID=No is defined on the PU. If this value is not negotiated, the Maximum
I-Field Size must match the MAXDATA value defined on the host system.

Note:The adapter frame size (transmit buffer size) should be set to at least 36
bytes larger than the maximum I-field (PIU) size.

Receive Window Count
This value is negotiated between your workstation and the host system,
unless XID=No is defined on the PU. If this value is not negotiated, the Receive
Window Count must match the MAXOUT value defined on the host system.

Using a PCMCIA Token-Ring or Ethernet Card
The IBM Token-Ring and Ethernet credit card adapters are supported in the
same way as full-size adapters.

LAN via NetWare for SAA Attachment

You can have 3270 sessions on an IPX/SPX network through a NetWare for
SAA Gateway. For this attachment, you need a token-ring, an Ethernet, or a
workstation network adapter.

NetWare Client for OS/2
Before you use a PC/3270 LAN via NetWare for SAA connection, install
NetWare Client for OS/2 and add SPX Support for OS/2 sessions as optional
protocols.

If your workstation is on a token-ring network with source-routing bridge,
ROUTE.SYS must be specified in your CONFIG.SYS. ROUTE.SYS is
supplied with NetWare Client for OS/2.

For more information, refer to the NetWare Client manual for OS/2.
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The default value for the number of SPX sessions is 16. If you want to use
more than 16 host sessions, edit NET.CFG and increase the number of SPX
sessions.

You should also note the number of IPX sockets. The NetWare Requester
requires at least three sockets per server connection, and Personal
Communications requires two sockets per host session. The default value for
the number of IPX sockets is 64. If you want to use several server connections
and host sessions at the same time, you might need to increase the number of
IPX sockets.

Example of NET.CFG
PROTOCOL STACK SPX

SESSIONS 32

PROTOCOL STACK IPX
SOCKETS 128

For more information, refer to the manuals or the online help for the NetWare
Client for OS/2.

Using an Asterisk for the Server Name and Service Name
You can enter an asterisk (*) instead of the server name or the service name.
However, if you do this and there are several servers on the network, you
might access more than one server.

If you have a password-protected user name, you must enter the correct
password in the password-entry window.

If there are several NetWare servers on your network and more than one has
a definition for the same user name that you specify, the first Password
window might be for another server instead of the server that you want to
use.

In this case, when you select Cancel, the Password window for the next
server appears. Repeat this action until you can enter your password for the
correct server.

Restrictions
The following functions are not available with this connectivity.
v SDDLU (self-defining dependent LUs)
v SNA session-level compression and decompression
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TCP/IP Connection

This section provides information, considerations, and restrictions for Personal
Communications TCP/IP connections.

Telnet3270 Attachment
Before Telnet3270 attachment is used, TCP/IP Version 2.0 for OS/2 Base Kit or
later must be installed. For more information, refer to IBM TCP/IP Version 2.0
for OS/2: Installation and Administration.

At the Telnet3270 server in a host system to which you want to connect, IBM
TCP/IP for VM or IBM TCP/IP for MVS must be running.

Restrictions
v The following functions are not available with this connectivity.

– SDDLU (self-defining dependent LUs)
– SNA session-level compression and decompression
– The maximum packet size must be less than 8000 bytes for file transfer

(SBCS only).

Host-Addressable Printing
Host-addressable printing is supported with the Telnet3270 attachment, using
the TN3287 or TN3270E protocols. You need to attach through a Telnet3270
server, which supports these protocols.

Screen Size
The following four screen sizes are supported:

24 x 80
32 x 80
43 x 80
27 x 132

Telnet5250 Attachment
Before Telnet5250 attachment is used, TCP/IP Version 2.0 for OS/2 Base Kit or
later must be installed. For more information, refer to the IBM TCP/IP Version
2.0 for OS/2: Installation and Administration.

Session Type
Telnet5250 supports the display session only.

SDLC Attachment

This section describes factors you should consider when configuring Personal
Communications with an SDLC attachment.
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Line Speed
For the SDLC attachment, the line speed will vary depending on the carrier
speed the modem supports.

V.25 bis Autodial
Personal Communications only supports the bit-oriented (HDLC) protocol for
V.25 bis call control messages. Modems must support an ASCII-coded
character set consisting of 7-bit characters with odd parity.

Personal Communications supports V.25 bis operation with
Multiprotocol(MPA) interface compatible adapters such as the:
v IBM Multiprotocol Communications Adapter (73G7099)
v IBM Multiprotocol Adapter/A (645114 or later)
v IBM Async/SDLC Communications Adapter (ASCA) (42H4332)

Performance Considerations
If you use multiple sessions in a high-speed and high-load configuration with
an SDLC attachment, the connection to the host might fail. In this case, set the
host’s timeout value to be greater than that of Personal Communications.
v To change the host timeout value, modify the following NCP parameters:

REPLYTO
The maximum duration in seconds that the host waits for a reply
from the terminal. The default is 1 second.

RETRIES=(m,t,n)
The number of attempts to be made to recover from errors occurring
during transmission over the link. Repetitive retries are called a retry
sequence. The maximum number of retries is specified as mj, which
can be from 0 to 128. NCP pause (the time between the retry
sequences) is specified as t and can be from 1 to 255 seconds. The
maximum number of retry sequences is specified by n and can be
from 1 to 127.

For example:
REPLYTO=1, RETRIES=(3,4,5)
(( 1(seconds) x 3(times) + 4(seconds)) x 5(times)
= 35 (seconds)

106 Personal Communications Quick Beginnings



Note

In this example, the host will wait 35 seconds for the terminal to
reply.

For more details, ask your system personnel.
v To change the timeout, modify the secondary inactivity timer through the

configuration dialog or advanced configuration.
The value is in seconds and can be from 40 to 160. The default is 80.

Maximum I-Field (PIU) Size
This value is negotiated between your workstation and the host system,
unless XID=No is defined on the PU. If this value is not negotiated, the Maximum
I-Field Size must match the MAXDATA value defined on the host system.

Receive Window Count
This value is negotiated between your workstation and the host system,
unless XID=No is defined on the PU. If this value is not negotiated, the Receive
Window Count must match the MAXOUT value defined on the host system.

Preventing Conflicts with MPA Adapters
The multiprotocol adapters use system resources that, in some cases, cannot
be shared. Therefore, you must make sure there are no conflicts with the
following resources:
v DMA level
v I/O addresses (MPA0 uses X’380’ - X’38F’ and MPA1 uses

X’3A0’ - X’3AF’)
v IRQ level (ISA bus only)

The IBM Multiprotocol interface adapters use the following system resources:
v The MPA for ISA can be supported using mode 4 (IRQ3, IRQ4, and DMA

channel 1) or mode A (IRQ4 and DMA channel 1). The ASCA can be
supported using mode 4 (IRQ3 or IRQ5, IRQ4 or IRQ7, and DMA channel
1) or mode A (IRQ4 or IRQ7, and DMA channel 1. The interrupt level
setting in the Personal Communications configuration dialog must match
the values on the adapter card. Personal Communications supports the
MPA0 or MPA1 communication ports. Some sound cards use an I/O
address within the range X’380’ - X’38F’. MPA1 should be used to avoid a
conflict.
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v The MPA/A for a microchannel-bus workstation uses IRQ3, IRQ4, and the
DMA level is configurable. Both the MPA0 and MPA1 communication ports
can be active at the same time and the interrupt is claimed as sharable.

Advantis (IIN) Attachment

Advantis (IIN) supports only a single adapter, and you cannot use other
connections at the same time.

Sharing the Interrupt Level
At ASYNC attachment, interrupt levels 3 (IRQ3) and 4 (IRQ4) are used for
hardware control. If this unit shares those interrupt levels with another unit,
communication might fail.

Line Speed
Line speeds up to 38,400 bps are supported. The maximum usable line speed
depends on the speed of the processor or communication port, however. If
communication stops or becomes exceedingly slow, reduce the line speed.

Modem Configuration
Software flow control (XON, XOFF) must be disabled.

Hayes AutoSync Attachment

Performance Considerations Because the Hayes AutoSync attachment
requires high speed between the serial port and the modem, you need a
486-class workstation with a 33 MHz CPU or better.

If your connection fails (for example, the communication is very slow or
stops), try a lower line speed. The line speed must be set in the configuration
dialog for Hayes AutoSync attachment or through Advanced configuration.

If the line disconnects or an error occurs during connection, reduce the line
speed or the PIU size. This might happen because the performance of your
workstation is too slow or the line is poor.
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IBM Global Network Connection Attachment

Note

The IBM Global Network may have been replaced by the AT&T
Business Internet Services in your country; if so, the following
applies to that service in the same manner.

IBM Global Network Connection supports only a single communication port.

Sharing the Interrupt Level
At IBM Global Network Connection, interrupt levels 3 (IRQ3) and 4 (IRQ4)
are used for hardware control. If this unit shares those interrupt levels with
another unit, communication might fail.

Line Speed
At IBM Global Network Connection, up to 38,400 bps is supported as the line
speed. However, the maximum usable line speed depends on the speed of the
processor or communication port. If communication stops or becomes
exceedingly slow, reduce the line speed.

Functions Not Available with the IBM Global Network Connection
You cannot use the following functions:
v Import/Export
v Host graphics
v Host print
v Server-Requester Programming Interface (SRPI)

Home3270 Attachment

Home3270 supports only a single adapter, and you cannot use other
connections at the same time.

Line Speed
Line speeds up to 57,600 bps are supported. However, characters might be
lost on high-speed lines, depending on the processor speed. If communication
stops or becomes exceedingly slow, reduce the line speed.
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Unsupported Character Sequences
The following character sequence is valid for the Home3270 attachment.
However, it performs no function.
v ESC P 1 (Block cursor command)
v ESC P 0 (Underline cursor command)
v DLE DC2 (Printer start command)
v DLE DC4 (Printer end command)

Conditions for Communication Check 50x
Home3270 requires both Data Set Ready (DSR) and Carrier Detect (CD) to
determine the state of the attachment with the host system. If DSR is not
recognized, communication check 501 appears in the operator information
area. When DSR is recognized, if CD is not recognized, communication check
504 appears in the operator information area.

When you select ROLMphone** with DCM in the Home3270 configuration,
communication check 504 does not appear.

3270 Attachment via the AS/400 System

This section provides information, considerations, and restrictions for PC/3270
connections through an AS/400 system.

AS/400 System Setup
PC/3270 can connect to a host computer via one or more AS/400 systems by
using the passthru function (usable with OS/400 Version 2.2.0 or later)
supplied through an AS/400 system.

To use this function, set the following communication configuration
descriptions in the AS/400 system to on (Vary On):
v Line description
v Controller description
v Printer description

Error Messages from the AS/400 System
When this system is connected to an S/390 host system via the AS/400
system, the following message might appear on the screen.

AS/400 CPI5xxx

The message might appear for the following reasons:
v Line error between the AS/400 system and the host system
v Communication configuration description error in the AS/400 system
v The communication configuration description in the AS/400 system is set

off (Vary Off).
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When this message appears, detailed error information is saved in the AS/400
system operator message queue. Refer to the error message that corresponds
to the number displayed on the screen and then correct the cause of the error.

SNA Considerations

This section describes factors you should consider when configuring Personal
Communications for use with SNA applications.

SDDLU
PC/3270 supports the self-defining dependent logical units (SDDLU) function
of ACF/VTAM Version 3 Release 4.1 (MVS) or Version 3 Release 4 (VM).
SDDLU provides the ability to dynamically create dependent LUs on
predefined PUs and to reconfigure dependent LUs without interruption to any
other user on the network and without intervention by system programming
or operations staff.

PC/3270 SDDLU is supported for all connections except DFT (coaxial
connection).

PC/3270 network stations support SDDLU by:
v Accepting a format-1 Activate PU (ACTPU), which signals that VTAM

requires a Network Management Vector Transport (NMVT) containing the
Product Set ID (PSID) and LOCADDR of the LU.

v A PC/3270 network station will use LOCADDRs 02, 03, 04, and so on, in
that sequence, by default. However, if you specify the LU addresses
explicitly, it will use the addresses that you specify.

v Sending an unsolicited NMVT to VTAM when an LU switches on.

PSID Definitions
PC/3270 defines the default PSID for each LU type. Generally, the PSID
contains such things as the machine type and the model number. The
following table describes the machine type and model number definitions for
each LU type supported by PC/3270.

Machine
Type

Model
Number

LU Type Screen/Buffer Size

3270 002 Display Model 2 screen 24 rows by 80 columns

3270 003 Display Model 3 screen 32 rows by 80 columns

3270 004 Display Model 4 screen 43 rows by 80 columns

3270 005 Display Model 5 screen 27 rows by 132 columns

3270 DS2* Printer 3270 data stream 24 rows by 80 columns

3270 DS3* Printer 3270 data stream 32 rows by 80 columns
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Machine
Type

Model
Number

LU Type Screen/Buffer Size

3270 DS4* Printer 3270 data stream 43 rows by 80 columns

3270 DS5* Printer 3270 data stream 27 rows by 132 columns

3270 00A Display 48 rows by 80 columns

3270 00B Display 62 rows by 160 columns

3270 00C Display 24 rows by 132 columns

* PC/3270 assumes that 3270 data stream is the default printer-session type. If
you use the SNA Character String (SCS) data stream, you must use a
different designation for the PSID, such as 3270SCS. You must define this
yourself, as shown in the next example.

Assigning User-Defined PSIDs
You can replace the default PSID values with your own definitions or define
new PSIDs, by preparing a PSID definition file or by changing the Windows
workstation profile. The PSIDs you use must be defined to VTAM.

Add a statement such as the following one to the [LU] definition in the
workstation profile. This example supersedes the default PSID with LUA0001.
PSID = LUA0001

Twinaxial Attachment (APPC)

This section describes considerations for twinaxial attachments (APPC).

PCMCIA Adapter
The PC400 communication driver for the twinaxial attachment corresponds to
the PCMCIA adapter. You do not have to use the driver supported with
PCMCIA adapter. (PCMCIA support must be loaded by the OS/2 Install
program.)

Twinaxial Attachment (Console)

Use the twinaxial attachment only when your workstation is used as an
AS/400 console. Do not attempt to use this feature when your workstation is
being used as a stand-alone unit.

5250 Data Stream
The extended 5250 data stream for using the extended user interface, the
Enhanced Non-programmable Terminal User Interface (ENPTUI), cannot be
transferred from the host system.
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Hotspots
Because Personal Communications treats all fields as unprotected fields, none
of the 3-dimensional hotspot buttons appear. To make these buttons visible,
add the following lines in your workstation profile:
[3DHotSpot]
ShowOnUPField=Y

Restrictions
v You cannot use the Setup API functions of the File menu.
v When you use twinaxial attachment (Console), you can only use Copy of

the Edit functions.
v You cannot use the file transfer function.
v You cannot set the session type to Printer.
v You cannot use multiple console sessions.
v The screen size is always 24 x 80, even if you specify 27 x 132.
v APIs are not supported.
v The PC Organizer cannot be used.
v You cannot use the mouse to move the cursor position.

Asynchronous Console

Use an asynchronous console only when a workstation is used as an AS/400
console. Do not use it in the usual operation. It is not a problem that OIA
message 504 appears at IPL.

Restrictions
An asynchronous console has the following restrictions:
v Multiple console sessions cannot be used.
v APIs are not supported.
v The session type cannot be set to the Printer.
v The file transfer function is not supported.
v The PC Organizer cannot be used.
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Appendix C. AS/400 Configuration Examples

To connect PC400 to an AS/400 system, you need to specify configuration
information in the workstation profile that accurately corresponds to the
information specified in the AS/400 system (referred to as the device
description).

For example, the LAN attachment via IEEE 802.2 in the following figure
shows how the configuration information specified in the PC400 workstation
profile corresponds to the configuration information in the AS/400 system.
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AS/400 Device Description

To configure 5250 display or printer sessions, the following values must be set
in the AS/400 device description:

AS/400 Device
Description

Display Session Printer Session

24 x 80 27 x 132

Device category *DSP *DSP *PRT

Device class *VRT *VRT *VRT

Device type 3197 3477 3812
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AS/400 Device
Description

Display Session Printer Session

24 x 80 27 x 132

Device model C1 FC 1

Keyboard language
type

USB(+) USB(+) -

Character identify
code page selection

697 037(+) 697 037(+) - (+) For SBCS,
depends on the host
code

5250 Sessions through One Link
If you want all your 5250 sessions to connect through one link to an AS/400
system, use the same PC Location Name and the same Link Parameters for
all the sessions.

For example, you can configure two display sessions and one printer session
connected to an AS/400 system using APPN.PC5250 as the Location Name.

Session A : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session B : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session C : Session Type : Printer
(Printer) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : PCLOCALP1

In this example, the AS/400 network attributes are:
Local network ID : APPN
Local location : S7801234

Tip

Enter DSPNETA from a 5250 session to display AS/400 network
attributes.
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AS/400 System Mode Description

PC400 initially uses mode description QPCSUPP on the AS/400 system. If the
PC Support/400 program or Client Access/400 is installed on the AS/400
system, QPCSUPP need not be created. If mode description QPCSUPP does
not exist on the AS/400 system, create the mode description:
1. Enter the following command on the command line of the main menu of

the AS/400 system:
CRTMODD

The Creating Mode Description panel appears.

Creating Mode Description (CRTMODD)

Type the selected items, and push the Enter key.

Mode Description................. Name
Maximum Session.................. 8 1-512
Maximum number of interaction.... 8 1-512
Number of Local Control Sessions. 4 0-512
Number of Pre-joined Sessions.... 0 0-512
Inbound Pacing Value............. 7 0-63
Outbound Pacing Value............ 7 0-63
Maximum Length of Request Unit... *CALC 241-16384, *CALC
Text Description ................ *BLANK

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

2. Type the necessary values in each field, according to the following table.

Field Name Input Value

Mode description QPCSUPP

Maximum session 64

Maximum number of interactions 64

Number of local control sessions 0

Number of pre-joined sessions 0

Inbound pacing value 7

Outbound pacing value 7

Maximum length of request unit *CALC

Text description This field is optional

3. After you type all the values, press the Enter key.
This completes the creation of the mode description QPCSUPP.
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AS/400 Device Description for Twinaxial Attachments (APPC) Example

If you want to use a twinaxial (TDLC) attachment, the AS/400 system
requires that you specify a device description. When the automatic device
configuration indicator (QAUTOCFG) is set to ON in the AS/400 system, the
device description is created automatically. When the indicator is set to OFF,
create the device description, as follows:
1. Enter the following command on the command line of the AS/400 system

main menu:
CRTDEVDSP

The Creating Device Description(Display) panel appears.

Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description... Name
Device Class.......... *LCL, *RMT, *VRT, *SNPT
Device Type........... 3101, 3151, 3161, 3162...
Device Format........ 0, 1, 2, 4, 11, 12, 23...

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

2. Type the values in each field, according to the following table.

Field Name Input Value

Device description This is an optional field

Device class *LCL

Device type 5150

Device format 2

3. After you type all values, press the Enter key.
The following screen appears:
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Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description..........>TWXP0A1 Name
Device Class................>*LCL *LCL, *RMT, *VRT, *SNPT
Device Type.................>5150 3101, 3151, 3161, 3162...
Device Format...............>2 0, 1, 2, 4, 11, 12, 23...
Port Number................. 0-17
Switch Setting.............. 0, 1, 2, 4, 5, 6
Online when IPL.............>*YES *YES, *NO
Controller to be attached... Name
Keyboard Word Type..........>*SYSVAL *SYSVAL,AGB,AGI,BLI...
Text Description............>*BLANK

F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

4. Type the values for each field, according to the following table.

Field Name Input Value

Port number Number of the port to be attached

Switch setting Device address

Controller to be attached Description name of the controller to be
attached

Keyboard word type USB(1) (1) Depends on the host code
page selection.

5. After you enter all the values, press the Enter key.
This completes the creation of the device description for the twinaxial
attachment.

AS/400 Device Description for Asynchronous Attachments Example

If you want to use an asynchronous dial attachment, the AS/400 system
requires that you specify configuration parameters for the
controller/line/devices to be used.

The following sample is a typical configuration on the AS/400 system for an
asynchronous dialed connection through an ASCII Workstation Controller.
1. Enter the following command on the command line of the AS/400 system

main menu:
WRKCFGSTS *CTL CTL03
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where CTL03 is the name of your controller.

The Work with Configuration Status panel appears.

Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
8_ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNC VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
__ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

2. Enter 8 in the Opt field to work with the controller description for CTL03.
The Work with Controller Descriptions panel appears.

Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
2_ CTL03 6141 CREATED BY AUTO-CONFIGURATION

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

3. Enter 2 in the Opt field to change the controller description for CTL03.
The Change Controller Description panel appears.
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Change Ctl Desc (local WS) (CHGCTLLWS)

Controller Description . . . . . . : CTL03
Option . . . . . . . . . . . . . . : *BASIC
Category of controller . . . . . . : *LWS

Controller type . . . . . . . . . : 6141
Controller model . . . . . . . . . : 1
Resource name . . . . . . . . . . : CTL03
TDLC line . . . . . . . . . . . . : QTDL429000
Online at IPL . . . . . . . . . . : *YES
Auto-configuration controller . . : *YES
Text . . . . . . . . . . . . . . . : CREATED BY AUTO-CONFIGURATION
Device wait timer . . . . . . . . : 10

Press Enter to continue.
===>

BOTTOM
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

4. Type the values in each field, according to the following table.

Field Name Input Value

Controller description CTL03

Resource name CTL03

Online at IPL *YES

Device wait timer 10

Auto-configuration controller *YES

Text description This field is optional

The Work with Controller Descriptions panel appears.
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Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
8_ CTL03 6141 Created by auto-configuration

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

5. Enter 8 in the Opt field to work with the configuration status.
The Work with Configuration Status panel appears.

Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
__ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNCPERTH VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
8_ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

6. Enter 8 in the Opt field next to ASYNRTR to work with the display device
description.
The Work with Device Descriptions panel appears.

Appendix C. AS/400 Configuration Examples 123



Work with Device Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source

Opt Controller Type Text
2_ ASYNRTR 5150 FOR PC400

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

7. Enter 2 in the Opt field to change the device description.
The Change Device Description panel appears.

Change Device Desc (Display) (CHGDEVDSP)

Type choices, press Enter.

Device description . . . . . . . . > ASYNRTR Name
Port number . . . . . . . . . . . 4 0-17, *SAME
Switch setting . . . . . . . . . . 0 0-6, *SAME
Online at IPL . . . . . . . . . . *YES *SAME, *YES, *NO
Keyboard language type . . . . . . USI *SAME, *SYSVAL, *NONE, AGB...
Keyboard language type . . . . . . JKB *SAME, *SYSVAL, *NONE, AGB...
Character identifier:

Graphic character set . . . . . *KBDTYPE 1-32767, *KBDTYPE, *SYSVAL...
Code page . . . . . . . . . . . 1-32767

Allow blinking cursor . . . . . . *YES *SAME, *YES, *NO
Print device . . . . . . . . . . . *SYSVAL Name, *SAME, *SYSVAL
Output queue . . . . . . . . . . . *DEV Name, *SAME, *DEV

Library . . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . . QSYSPRT Name, *SAME

Library . . . . . . . . . . . . *LIBL Name, *LIBL, *CURLIB
More...

Press Enter to continue.
===>
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

This completes the creation of the controller and display device
descriptions for an asynchronous dial attachment.
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AS/400 Device Description for Hayes AutoSync Attachments Example

If you want to use a Hayes AutoSync attachment, the AS/400 system requires
that you specify configuration parameters for the controller/line/devices to be
used.

The following sample is a typical configuration on the AS/400 system for an
AutoSync connection either through an ASCII Workstation Controller
(configured for a synchronous switched connection type) or the Electronic
Customer Support (ECS) line.
1. Enter the following command on the command line of the AS/400 system

main menu:
WRKCFGSTS *CTL CTL03

where CTL03 is the name of your controller.

The Work with Configuration Status panel appears.

Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
8_ AUTOHAYES CONNECT PENDING
__ AUTONAGA VARIED OFF
__ AUTOSYNC VARIED OFF
__ AUTOSYNC1 CONNECT PENDING

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

2. Enter 8 in the Opt field next to AUTOHAYES to work with the line
description.
The Work with Line Descriptions panel appears.

Appendix C. AS/400 Configuration Examples 125



Work with Line Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source

Opt Controller Type Text
2_ AUTOHAYES *SDLC Hayes Autosync Line for PC400

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

3. Enter 2 in the Opt field to display the line description.
The Change Line Description panel appears.

Change Line Desc (SDLC) (CHGLINSDLC)

Type choices, press Enter.

Line description . . . . . . . . . > AUTOHAYES Name
Resource names . . . . . . . . . . LIN051 Name, *SAME

+ for more values
Online at IPL . . . . . . . . . . *YES *SAME, *YES, *NO
Vary on wait . . . . . . . . . . . *YES *NOWAIT, 15-180 (1 second)
NRZI Data encoding . . . . . . . . *YES *SAME, *YES, *NO
Maximum controllers . . . . . . . 1 1-254, *SAME
Clocking . . . . . . . . . . . . . *MODEM *SAME, *MODEM, *LOOP
Line speed . . . . . . . . . . . . 9600 *SAME, 600, 1200, 2400...
Modem type supported . . . . . . . *NORMAL *SAME, *NORMAL, *V54...
Modem data rate select . . . . . . *FULL *SAME, *FULL, *HALF
Switched connection type . . . . . *BOTH *SAME, *BOTH, *ANS, *DIAL
Autoanswer . . . . . . . . . . . . *YES *SAME, *YES, *NO
Autodial . . . . . . . . . . . . . *NO *SAME, *YES, *NO
Dial command type . . . . . . . . *SAME *SAME, *NONE, *V25BIS
Calling number . . . . . . . . . . *NONE

More...
===>
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

4. Type the required values and press Enter.
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Change Line Desc (SDLC) (CHGLINSDLC)

Type choices, press Enter.

Station address . . . . . . . . . > AUTOSYNC 01-FE, *SAME
Connect poll retry . . . . . . . . 7 0-64, *SAME
Maximum frame size . . . . . . . . 521 *SAME, 265, 521, 1033, 2057
Error threshold level . . . . . . *HALF *SAME, *OFF, *MIN, *MED, *MAX
Duplex . . . . . . . . . . . . . . *HALF *SAME, *HALF, *FULL
Modulus . . . . . . . . . . . . . 8 *SAME, 8, 128
Maximum outstanding frames . . . . *BASIC 1-28, *SAME
Inactivity timer . . . . . . . . . *SDLC *NOMAX, 150-4200 (0.1 sec)
Poll response delay *SAME 0-2048 (O.0001 seconds)
Nonproductive receive timer . . . 320 160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . . 30 5-300 (0.1 seconds)
Connect poll timer . . . . . . . . 30 2-300 (0.1 seconds)
Poll cycle pause . . . . . . . . . 0 0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . . 7 0-64, *SAME
Data Set Ready drop timer . . . . 6 *SAME, 3-60 (seconds)
Autoanswer type . . . . . . . . . *DTR *SAME, *DTR, *CDSTL

More...
===>
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Type the required values and press Enter.

Change Line Desc (SDLC) (CHGLINSDLC)

Type choices, press Enter.

Clear to Send timer . . . . . . . 25 *SAME, 10-60 (seconds)
Remote answer timer . . . . . . . 60 *SAME, 30, 35, 40 (seconds)...
Link speed . . . . . . . . . . . . 9600 *SAME, *INTERFACE, *MIN...
Cost/connect time . . . . . . . . 128 0-255, *SAME, *CNN
Cost/byte . . . . . . . . . . . . 128 0-255, *SAME, *CNN
Security for line . . . . . . . . *NONSECURE *SAME, *NONSECURE...
Propagation delay . . . . . . . . *TELEPHONE *SAME, *MIN, *LAN...
User-defined 1 . . . . . . . . . . 128 0-255, *SAME
User-defined 2 . . . . . . . . . . 128 0-255, *SAME
User-defined 3 . . . . . . . . . . 128 0-255, *SAME
Recovery limits:

Count limit . . . . . . . . . . 2 0-99, *SAME, *SYSVAL
Time interval . . . . . . . . . 5 0-120 (minutes)

Text 'description' . . . . . . . 'Hayes AutoSync Line for PC400
Bottom

Press Enter to continue.
===>
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Type the required values and press Enter.

The Work with Line Descriptions panel appears.
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Work with Line Descriptions
SYSTEM: TOK38SPB

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source

Opt Controller Type Text
__ AUTOHAYES *SDLC Hayes Autosync Line for PC400

BOTTOM
Parameters or command
===> ________________________________________________________________________
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

This completes the creation of the line description for a Hayes AutoSync
attachment.
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Appendix D. Default Key Function Assignments

This appendix lists the functions assigned, by default, to each key on your
keyboard.

For more information about each function, refer to the Keyboard choice on
the Help menu.

Default Key Functions for PC/3270

Table 4 shows the default key functions for PC/3270. The column for the
Enhanced keyboard applies to both the 101-key, 102-key, and 104-key
keyboards, as well as the Space-Saving keyboard.

Table 4. Default Key Functions for a 3270 Layout

Function of Key Enhanced Keyboard Host-Connected Keyboard

APL Ctrl+F8 Ctrl+F8

Attention Esc Attn

Alternate Cursor Alt+F11 AltCr

Backspace ← (Backspace) ←

Back Tab Shift+→| |←

Back Tab Word Alt+← Alt+←

Break Break Ctrl+Space(pad)

Change Format Toggle Alt+F3 Alt+F3

Change Screen Ctrl+PageUp ChgSc

Clear Pause Clear

Color Blue Ctrl+Shift+F5 Alt+F17

Color Field Inherit Ctrl+Shift+F8 Alt+F20

Color Green Ctrl+Shift+F3 Alt+F15

Color Pink Ctrl+Shift+F2 Alt+F14

Color Red Ctrl+Shift+F1 Alt+F13

Color Turquoise Ctrl+Shift+F6 Alt+F18

Color White Ctrl+Shift+F7 Alt+F19

Color Yellow Ctrl+Shift+F4 Alt+F16

Cursor Blink Ctrl+F10 CrBnk

Cursor Down ↓ or 2(pad) ↓
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Table 4. Default Key Functions for a 3270 Layout (continued)

Function of Key Enhanced Keyboard Host-Connected Keyboard

Cursor Left ← or 4(pad) ←

Cursor Right → or 6(pad) →

Cursor Select Ctrl+F9 CrSel

Cursor Up ↑ or 8(pad) ↑

Delete Character Delete or .(pad) Delete

Delete Word Ctrl+Delete or Ctrl+.(pad) DelWd

Document Mode Toggle Alt+F1 Alt+F1

Dup Shift+Insert² Dup

Edit Copy Ctrl+Insert Ctrl+Insert

Edit Cut Shift+Delete Shift+Delete

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Shift+Insert

Edit Undo Alt+← (Backspace) Alt+←

End Field Pad End Not assigned

Enter Enter Enter

Enter/Control Right Ctrl Enter

Erase EOF End² ErEOF

Erase Field Shift+End² Not assigned

Erase Input Alt+End² ErInp

Fast Cursor Down Alt+↓ or Alt+2(pad) Alt+↓

Fast Cursor Up Alt+↑ or Alt+8(pad) Alt+↑

Field Mark Shift+Home² FldMk

Graphic Cursor Alt+F12 Alt+F24

Highlighting Field Inherit Alt+3(pad) Alt+F12

Highlighting Reverse Alt+*(pad) Ctrl+F9

Highlighting Underscore Alt+6(pad) Ctrl+F11

Home Home or 7(pad) Alt+Rule

Insert Insert or 0(pad) Insert

Jump Next Alt+PageUp Jump

New Line Í┘ (Enter) Í┘

Mark Down Shift+↓ Shift+↓

Mark Left Shift+← Shift+←

Mark Right Shift+→ Shift+→
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Table 4. Default Key Functions for a 3270 Layout (continued)

Function of Key Enhanced Keyboard Host-Connected Keyboard

Mark Up Shift+↑ Shift+↑

Move Mark Down Ctrl+↓ or Ctrl+2(pad) Ctrl+↓

Move Mark Left Ctrl+← or Ctrl+4(pad) Ctrl+←

Move Mark Right Ctrl+→ or Ctrl+6(pad) Ctrl+→

Move Mark Up Ctrl+↑ or Ctrl+8(pad) Ctrl+↑

PA1 Alt+Insert² PA1

PA2 Alt+Home² PA2

PA3 Shift+PageUp² PA3

Pause Ctrl+F7 Pause

PF1 to PF12 F1 to F12 F1 to F12

PF13 to PF24 Shift+F1 to F12 F13 to F24

Play Ctrl+F6 Play

Program Symbol A Ctrl+Shift+(pad)1 Ctrl+Shift+(pad)1

Program Symbol B Ctrl+Shift+(pad)2 Ctrl+Shift+(pad)2

Program Symbol C Ctrl+Shift+(pad)3 Ctrl+Shift+(pad)3

Program Symbol D Ctrl+Shift+(pad)4 Ctrl+Shift+(pad)4

Program Symbol E Ctrl+Shift+(pad)5 Ctrl+Shift+(pad)5

Program Symbol F Ctrl+Shift+(pad)6 Ctrl+Shift+(pad)6

PS Field Inherit Ctrl+Shift+(pad)0 Ctrl+Shift+(pad)0

Print (Local Copy) Not assigned Not assigned

Quit (Device Cancel) Alt+Left Ctrl Alt+Left Ctrl

Record Ctrl+F5 Record

Reset/Control Left Ctrl Left Ctrl

Response Time Monitor Ctrl+F11 Ctrl+F19

Rule Ctrl+Home Rule

Sys Request Alt+PrintScreen SysRq

Tab Field →| or Shift+→|(pad) →| or →| (pad)

Tab Word Alt+→ Alt+→

Test Ctrl+PageDown Test

Transparency Field Inherit Ctrl+Shift+8(pad) Ctrl+Shift+9(pad)

Transparency Opaque Ctrl+Shift+/(pad) Ctrl+Shift+*(pad)

Word Wrap Toggle Alt+F2 Alt+F2
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Table 4. Default Key Functions for a 3270 Layout (continued)

Function of Key Enhanced Keyboard Host-Connected Keyboard

¹ Includes the 101-key and 102-key keyboard. The Space Saving keyboard is
like the Enhanced keyboard with the keypad omitted.

² Indicates the key on the main keyboard.

(pad) Indicates a key on the numeric keypad.

Note: The Enhanced keyboard has some duplicated keys. The functions of the
duplicated keys are the same except when you specify a single key. For example, Del
means any Delete key, whereas Pad Del specifies only the Delete key on the numeric
keypad.

Default Key Functions for PC400

Table 5 shows the default key functions for PC400. The column for the
Enhanced keyboard applies to both the 101-key, 102-key, and 104-key
keyboards, as well as the Space-Saving keyboard.

Table 5. Default Key Functions for PC400

Function of Key Enhanced Keyboard 122 Keyboard

Alternate Cursor Ctrl+F11 AltCr

Attention Esc Attn

Backspace ← (Backspace) ←

Backtab Shift+→| |←

Backtab Word Alt+← Alt+←

Begin Bold* Ctrl+B Ctrl+B

Begin of line* Ctrl+4(pad) Ctrl+4(pad)

Begin Underscore* Ctrl+U Ctrl+U

Bottom of Page* Ctrl+2(pad) Ctrl+2(pad)

Carrier Return Ctrl+Enter or Ctrl+- (pad)
or Ctrl++ (pad)

Ctrl+- (pad) or Ctrl+→|
(pad)

Center Text* Ctrl+C Ctrl+C

Clear Pause Clear

Cursor Blink Ctrl+F10 CrBnk

Cursor Down ↓ or 2(pad) ↓

Cursor Left ← or 4(pad) ←

Cursor Right → or 6(pad) →

132 Personal Communications Quick Beginnings



Table 5. Default Key Functions for PC400 (continued)

Function of Key Enhanced Keyboard 122 Keyboard

Cursor Up ↑ or 8(pad) ↑

Delete Character Delete or .(pad) Delete

Delete Word Ctrl+Delete or Ctrl+.(pad) DelWd

Display Text Code Alt+Insert Alt+Insert

Dup Shift+Insert PA1

Edit Copy Ctrl+Insert Ctrl+Insert

Edit Cut Shift+Delete Shift+Delete

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Shift+Insert

Edit Undo Alt+← (Backspace) Alt+←

End Bold/Underscore* Ctrl+J Ctrl+J

End of line* Ctrl+6(pad) Ctrl+6(pad)

End of page* Ctrl+P Ctrl+P

Enter/Control Enter/Ctrl Enter

Erase EOF End or 1(pad) ErEOF

Erase Input Alt+End ErInp

Fast Cursor Down Alt+V or Alt+2(pad) Alt+V

Fast Cursor Up Alt+↑ or Alt+8(pad) Alt+↑

Field Exit Enter(pad) or Í┘ (Enter) Enter(pad) or Í┘

Field Mark Shift+Home PA2

Field Minus (-) -(pad) Alt+-(pad)

Field Plus (+) + (pad) Alt+→|(pad)

Half Index Down* Ctrl+H Ctrl+H

Half Index Up* Ctrl+Y Ctrl+Y

Help Alt+F1 Alt+F1

Home Home or 7(pad) Alt+Rule

Host Print Ctrl+Pause Alt+F13

Insert Insert or 0 (pad) Insert

Insert Symbol* Ctrl+A Ctrl+A

Jump Next Alt+PageUp Jump

Mark Down Shift+↓ Shift+↓

Mark Left Shift+← Shift+←

Mark Right Shift+→ Shift+→
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Table 5. Default Key Functions for PC400 (continued)

Function of Key Enhanced Keyboard 122 Keyboard

Mark Up Shift+↑ Shift+↑

Move Mark Down Ctrl+↓ Ctrl+↓

Move Mark Left Ctrl+← Ctrl+←

Move Mark Right Ctrl+→ Ctrl+→

Move Mark Up Ctrl+↑ Ctrl+↑

New Line Shift+Í┘ (Enter) Shift+Í┘

Next Column* Ctrl+D Ctrl+D

Next Stop* Ctrl+N Ctrl+N

Pause Ctrl+F7 Pause

PF1 to PF12 F1 to F12 F1 to F12

PF13 to PF24 Shift+F1 to F12 F13 to F24

Play Ctrl+F6 Play

Quit Alt+Left Ctrl Alt+Left Ctrl

Record Ctrl+F5 Record

Required Backspace Ctrl+← (Backspace) Ctrl+←

Required Space* Ctrl+Space Ctrl+Space

Required Tab* Ctrl+→| Ctrl+→|

Reset/Control Left Ctrl Left Ctrl

Roll Down 9(pad) or PageUp 9(pad)

Roll Up 3(pad) or PageDown 3(pad)

Rule Ctrl+Home Rule

Stop Code* Ctrl+S Ctrl+S

System Request Shift+Esc Alt+PrintScreen

SysRq

Tab Field →| →| or →|(pad)

Tab Word Alt+→ Alt+→

Test Request Alt+Pause Alt+Copy

Top of Page* Ctrl+8(pad) Ctrl+8(pad)

Word Underscore* Ctrl+W Ctrl+W

(pad) indicates a key on the numeric keypad.

* indicates a Text Assist Key (SBCS only).

134 Personal Communications Quick Beginnings



Default Key Functions for the Combined Package

Table 6 shows the default key functions for the combined package. The
column for the Enhanced keyboard applies to both the 101-key, 102-key, and
104-key keyboards, as well as the Space-Saving keyboard.

When you use Personal Communications from the combined package, the
PC400 key assignments are added to the PC/3270 default key function
assignments for Personal Communications.

Table 6. Default Key Functions for the Combined Package

Function of Key Enhanced Keyboard Host-Connected Keyboard

Change Screen Not assigned ChgSc

Character Advance Shift+BackSpace Not assigned

Help Not assigned Ctrl+F1

Host Print Not assigned Ctrl+F13

PA3 Not assigned PA3

Roll Down PageUp Not assigned

Roll Up PageDown Not assigned

You can change the default key assignments to the following default function
tables, by selecting Keyboard Setup from the Assist menu:

KEYMAP_3270 (for PC/3270)
KEYMAP_5250 (for PC400)
KEYMAP_CONV (for the combined package)

The default function table setting is stored in your PCSWIN.INI file:
[KEYBOARD]
CuaKeyboard=n

where n indicates the emulation types installed:

3 for 3270 keyboard layout

5 for 5250 keyboard layout

c for combined keyboard layout
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Appendix E. Access Feature Configuration Profiles

The following sections contain more information:
v “Data Link Control (DLC) Profiles”
v “SNA Profiles” on page 140
v “X.25 Profiles” on page 145
v “SNA Phone Connect Profiles” on page 156

Data Link Control (DLC) Profiles

This section describes the data link control (DLC) profiles that you can
configure. The following subsections contain more information:
v “Introduction to DLC Profiles”
v “Configuring for DLC” on page 138
v “Profiles” on page 138

Introduction to DLC Profiles
The data link control (DLC) profiles establish interfaces between the DLC
adapter in your workstation and another system or workstation through a
logical link. The DLC provides the protocols necessary for reliable delivery of
basic transmission units (BTUs) between a pair of nodes in the SNA network.
You must configure the appropriate DLC profiles for a workstation to access
an SNA network.

The data link control connection types are:
v Token-ring or other LAN types
v Ethernet (ETHERAND) network
v PC Network
v Synchronous data link control (SDLC)
v X.25 using X.25 Coprocessor adapter
v X.25
v Integrated services digital network DLC (IDLC)
v Twinaxial
v GDLC for adapter-provided DLC

Refer to the online Communications Server for OS/2 Network Administration and
Subsystem Management Guide for additional background information on data
link controls.
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Configuring for DLC
To select a DLC profile, follow these steps:
v On the Configuration Definitions window, select:

– Additional definitions

– One of the connection types listed above from the Workstation
Connection Type list

– One of the items in the Feature or Application list
– Configure

v On the Profile List window, select the appropriate DLC profile.
The DLC profiles are also available by selecting Configure any profile or
feature... from the Options menu in the Configuration Definitions window.

Profiles
Following are discussions of the types of DLC profiles. While completing a
profile, use the online help for a description of the parameters.

DLC - Token-Ring or Other LAN Types Profile
Define a DLC Token-Ring or other LAN type profile for each Token-Ring or
other LAN type adapter in your workstation that you use to run an SNA
feature or application.

DLC - Ethernet (ETHERAND) Network Profile
Define a DLC Ethernet network profile for each Ethernet network adapter in
your workstation that you use to run an SNA feature or application.

DLC - PC Network Profile
Define a DLC PC Network profile for each PC Network adapter in your
workstation that you use to run an SNA feature or application.

DLC - SDLC Profile
Define a synchronous data link control (SDLC) DLC profile. The SDLC DLC
profile establishes the interface between the SDLC adapter in your
workstation and another system or workstation in an SNA environment.

DLC - X.25 Profile
Define a DLC X.25 profile to run SNA applications over an X.25
packet-switching data network (PSDN). Both SNA and non-SNA applications
can share an X.25 adapter.

The X.25 API supports up to eight X.25 adapters. However, the number of
X.25 adapters is limited by the available slots in your workstation. For each
X.25 adapter you intend to use for SNA communications, you must define an
X.25 DLC profile.
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When completing this profile, make sure the Link name parameter value
matches the link name defined in the X.25 link profile.

If you want to initiate a connection to one or more remote data terminal
equipment devices (DTEs), you must create remote SNA entries in the X.25
directory. See “X.25 Directory Entries Profile” on page 148 for more
information about the X.25 directory.

If you want to receive incoming calls from remote DTEs, check that the
IBM-supported X.25 routing table is configured to your requirements. See
“X.25 Routing Table Profile” on page 150 for additional information about the
X.25 routing table.

DLC - IDLC Profile
Define a DLC IDLC profile to connect your workstation by IDLC (ISDN data
link control) to an integrated services digital network (ISDN). IDLC is IBM’s
implementation of the CCITT standard Link Access Protocol-Extended
(LAPE).

Refer to the online Network Administration and Subsystem Management Guide for
an introduction to ISDN.

DLC - Twinaxial Profile
Define a DLC Twinaxial profile to enable your workstation to communicate
with an AS/400 computer. Twinaxial data link control (DLC) is a
communication function that allows personal computers, attached to an
AS/400 computer or to the workstation controller with a twinaxial cable, to
use advanced program-to-program communications (APPC).

DLC - GDLC for Adapter-Provided DLC Profile
Define a general DLC (GDLC) for adapter-provided DLC profile to provide a
bridge between the SNA subsystem and a vendor-supplied protocol adapter.
Most configuration parameters have been supplied by the vendor adapter
configuration program. You can configure whether this adapter receives
incoming calls.

To complete a general DLC configuration, you also need to configure:
v OEM or IBM intelligent adapter
v SNA connections profile
v SNA Phone Connect - Port Connection Manager profile

If you are configuring for an OEM or IBM intelligent adapter, the values you
specify in the configuration fields might be different from those displayed on
the panels and described in the online help. Use the information shipped with
the adapter to configure correctly.
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SNA Profiles

This section describes the SNA profiles that you can configure. The following
subsections contain more information:
v “Introduction to SNA Profiles”
v “Configuring for SNA”
v “Profiles” on page 141

Introduction to SNA Profiles
The SNA subsystem can act as both an SNA type 2.0 node and an SNA type
2.1 node. This support lets you write programs to communicate with many
other IBM SNA products.

When communication starts, it establishes local logical unit (LU) and logical
link definitions that are stored in a configuration. The systems management
application programming interface (API) provides functions that control
configuration definition and adapter and link activation.

The connection types for SNA profiles are:
v Token-ring or other LAN types
v Ethernet (ETHERAND) network
v PC Network
v Twinaxial
v Synchronous data link control (SDLC)
v X.25 using X.25 Coprocessor adapter
v X.25
v Integrated services digital network DLC (IDLC)
v GDLC for adapter-provided DLC

Refer to online Network Administration and Subsystem Guide for additional
background information.

Configuring for SNA
To select an SNA profile, follow these steps:
v On the Configuration Definitions window, select:

– Additional definitions

– One of the connection types listed in section “Connection Types and
Related Features or Applications” on page 33 from the Workstation
Connection Type list

– APPC APIs or CPI Communications in the Feature or Application list
– Configure

v On the Profile List window, select the appropriate SNA profile.
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If a quick configuration path is available, it is presented. To access the
advanced configuration path from the quick configuration window, select
the Advanced... push button.
The SNA profiles are also available by selecting Configure any profile or
feature... from the Options menu in the Configuration Definitions window.

Profiles
Following are discussions of the types of SNA profiles. While completing the
profile, use the online help for a description of the parameters.

SNA Local Node Characteristics Profile
The Systems Network Architecture (SNA) local node characteristics profile
contains the parameters needed to identify your workstation to the SNA
network. A host that is performing network management needs the network
ID and the control point (CP) name, also known as the local node name, so
that when the workstation sends alerts to the host, the host recognizes the
application running on the workstation.

For the local node characteristics profile, there are options for the local node
alias name, data compression, and activating the Attach Manager. You access
the local node characteristics options by selecting the Options... push button
on the Local Node Characteristics window.

SNA Connections Profile
The SNA Connections profile defines the connections from a workstation to
one or more SNA nodes. You can define connections to the following types of
nodes:

Network node
An adjacent node using the Advanced Peer-to-Peer Networking
(APPN) features and configured as a network node. The connection
between the nodes supports control point-to-control point (CP-CP)
sessions.

Peer node
An adjacent node configured as either an end node or an LEN node.
The connection between the nodes does not support CP-CP sessions.

Host An adjacent node that is a System/370 or Enterprise System/9000
(ES/9000)-based host containing an SSCP (for example, a VTAM host).
The connection between the nodes can optionally support CP-CP
sessions.

SNA Dependent LU Server Definitions Profile
The SNA Dependent LU Server Definition defines the connection between a
workstation and a dependent LU server. The dependent LU server handles
communications between dependent LUs through an APPN network to a
dedicated host.
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This profile lets you define:
v Connection between the workstation where the dependent LU resides and

the server
v Name of the primary and backup dependent LU server
v Physical unit name of the dedicated host
v Node ID or CPNAME of the server
v Whether a connection is automatically established to the dependent LU

server when Personal Communications is activated on the workstation
where the dependent LU resides

SNA Features Profile
The SNA features profile defines the following features:
v Local LUs
v Partner LUs
v Modes
v Transaction program definitions
v Transaction program defaults
v Transaction program security
v Conversation security
v LU-to-LU security
v CPI Communications side information

Before configuring the SNA features profile, you should define any data link
control (DLC) profiles and the local node characteristics profile.

SNA Network Definitions: Before configuring your SNA network, you
should be familiar with SNA networking terms and concepts and have your
SNA network (nodes, logical units, and transaction programs) planned. Refer
to the online Reference for background information on SNA networking terms
and concepts.

The SNA subsystem also provides the systems management programming
capabilities to configure a workstation to run advanced program-to-program
communications (APPC) applications and use Advanced Peer-to-Peer
Networking (APPN) capabilities. The systems management configuration
verbs enable application programs to create and modify the SNA resources
dynamically.

Local LUs Feature: The Local LU definition lets you configure both
independent and dependent LUs for the node configured for the workstation.

Instead of defining individual local LUs, you can use the control point (CP)
LU configured for the node.

142 Personal Communications Quick Beginnings



Partner LUs Feature: A partner LU definition is a listing in your
workstation’s directory that contains the name and alias of an LU with which
you communicate.

It is not always necessary to predefine partner LUs before communication.
You can use implicit partner LUs. However, you must define all partner LUs
that are referred to by an alias by the transaction programs on the local node.

If you are using the APPN networking features, you can define the partner
LU definition without defining the partner LU location. Otherwise, you must
define the partner LU when you are creating the connection to the node that
owns the partner LU.

Modes Feature: A mode describes the class of service and transmission
characteristics for communication sessions between LUs. You can establish
several mode definitions, each describing a different set of session
characteristics. After you create a mode definition, you can assign a unique
mode name to a specific set of session characteristics. You can use the mode
name to set up session characteristics for all workstations that require them.

Some reasons you might have to define your own mode are:
v Your partner supports only single sessions.
v Your transaction program (TP) is running on a dependent LU.
v The supplied receive pacing window is inappropriate and adaptive pacing

is not used.
v Your transaction program uses a different mode name than what is

supplied and the implicit mode capability is not used.

Instead of defining individual modes, you can use the IBM-supplied modes
for the LU sessions. You need to define a mode only if you need a specific
mode name defined or if you need to modify the mode characteristics.
However, three of the IBM-supplied modes (SNASVCMG, CPSVCMG, and
CPSVRMGR) cannot be changed at any time.

Transaction Program Definitions Feature: A transaction program (TP) is a
set of instructions that uses APPC or CPI-C communication functions. By
using these functions, your applications can communicate with other
applications on the network.

When you define a local transaction program (stored on your workstation),
you are providing the advanced program-to-program communications (APPC)
portion of your node with the information that is necessary to start the
processing for your transaction program. For example, you can determine
where on the disk your transaction program is located and then determine
whether it is necessary to assign a security level to it when it is started from a
remote location.
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You can configure transaction programs to start in any of the following ways:

Default
Defaults to the program type that the system detects from the
executable file. For example, if the TP is a WIN-OS/2 program, it will
run in a full-screen WIN-OS/2 session.

Full screen
Uses the program type the system detects from the executable file and
runs it in a full-screen session. For example, if the transaction program
is a WIN-OS/2 program, it will run in a full-screen WIN-OS/2
session.

Window
Uses the program type the system detects from the executable file and
runs it in a window. For example, if the transaction program is a
WIN-OS/2 program, it will run in a windowed WIN-OS/2 session on
your OS/2 desktop.

Presentation Manager
If the program was written to use Presentation Manager functions, the
program starts in an OS/2 Presentation Manager window.

Background
The program starts in an OS/2 background process.

Transaction Program Defaults Feature: You can specify three default
properties for undefined transaction programs:
v The directory containing the executable program
v The transaction program presentation type
v The transaction program operation type

Transaction Program Security Feature: Transaction program security
information includes user IDs and passwords for all individuals who have
access to all protected programs. In addition to this, transaction program
security information lets you know which transaction programs require
passwords and which ones do not.

You can set whether conversation security is defined. By default, conversation
security is not required for any transaction program. If necessary, set the
security that is required for a transaction program.

After specifying that the transaction program security is required, you must
define the conversation security. Use the conversation security feature in the
SNA Features List window to set the conversation security.

Conversation Security Feature: When an incoming allocation request arrives
at this node and it contains a user ID and password, the APPC attach
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manager searches for a matching user ID and password combination within
the node security profiles. Using the Conversation Security window, you can
either explicitly define these user IDs and passwords or specify that the User
Profile Management (UPM) feature is used to verify security.

When defining these conversation security requirements, you should select to
either define the user IDs and passwords or use the UPM feature. You cannot
choose to use both.

Refer to Communications Server Quick Beginnings for more information on using
the UPM features.

LU-to-LU Security Feature: LU-to-LU security information includes
passwords for all individuals who have access to protected LUs. When you
create a security definition, each set of LUs is identified using a local LU alias
and a partner LU.

CPI Communications Side Information Feature: You can specify the
initialization information required by the CPI Communications subsystem to
establish a conversation with a partner program.

SNA LUA APIs Profile
The LUA APIs extend the capabilities of Personal Communications by
providing an API that supports communication between workstations and
host applications.

The LUA APIs profile defines the parameters that are needed to establish SNA
LU 0, LU 1, LU 2, and LU 3 communication sessions between a workstation
and a host application.

The LUA requires one of the following target host systems:
v S/390 architecture host
v AS/400

Refer to 32-bit Conventional LUA Programming Reference for more information
about the LUA API.

X.25 Profiles

This section describes the X.25 profiles that you can configure. The following
subsections contain more information:
v “Introduction to X.25 Profiles” on page 146
v “Configuring X.25” on page 146
v “Reconfiguring X.25 Support” on page 146
v “Profiles” on page 147
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Introduction to X.25 Profiles
Before configuring the X.25 feature, you should have a basic understanding of
X.25 concepts and how the X.25 feature is supported. Refer to the online
Network Administration and Subsystem Management Guide for more information.

You should also understand how your OS/2 workstations use X.25
applications to communicate with other workstations and computers. If your
organization has its own programmers who develop X.25 applications, you
need to work with them to plan for the applications and to configure X.25 on
the OS/2 workstations. Refer to 32-Bit X.25 Programming Reference for more
information about writing X.25 applications.

Configuring X.25
To select an X.25 profile, follow these steps:
1. On the Configuration Definitions window, select:
v Additional definitions

v X.25 or X.25 Using X.25 Coprocessor Adapter from the Workstation
Connection Type list

v One of the items in the Feature or Application list
v Configure

2. On the Profile List window, select the appropriate X.25 profile.
The X.25 profiles are also available by selecting Configure any profile or
feature... from the Options pull-down menu in the Configuration
Definitions window.

Reconfiguring X.25 Support
Once configured, X.25 support is customized for a particular network
connection. You do not need to reconfigure unless you do one or more of the
following things:
v Move to another X.25 link
v Connect to a different network
v Add more X.25 adapters to your workstation
v Move X.25 adapters to different slots

146 Personal Communications Quick Beginnings



Note

After Personal Communications has been installed on a
workstation that uses X.25 support, use the ARTIC command to
install ICAAIM.COM. If you are using an ISA machine, you will
also need an ICAPARM.PRM file that adheres to the format
outlined in your adapter documentation.

Profiles
The required (U) and optional (O) profiles for X.25 and X.25 Using X.25
Coprocessor Adapter are listed in the tables that follow. While completing the
profile, use the online help for a description of the parameters.

X.25 Profiles (Without X.25 Coprocessor Adapter)

Profile
Feature or Application

APPC
APIs

CPI
Com.

LUA
APIs

X.25
APIs

SNA Phone Connect - Port Connection
Mgr.

U U U U

SNA Phone Connect - Connection Mgr. U U U U

X.25 links U U U U

X.25 directory entries U U U O

X.25 routing table U U U O

DLC - X.25 U U U

SNA local node char. U U U

SNA connections O O U

SNA features O O U

SNA dependent LU server O U

SNA LUA APIs U

For more information about X.25 and SNA Phone Connect support, see “X.25
Network Access Using SNA Phone Connect” on page 160.
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X.25 Using X.25 Coprocessor Adapter Profiles

Profile
Feature or Application

APPC
APIs

CPI
Com.

LUA
APIs

X.25
APIs

X.25 links U U U U

X.25 directory entries U U U O

X.25 routing table U U U O

DLC - X.25 U U U

SNA local node char U U U

SNA connections O O U

SNA dependent LU server O U

SNA features O O

SNA LUA APIs U

X.25 Links Profile
The X.25 links profile defines the characteristics of the X.25 network you are
attached to. This profile specifies both link connection information and
network-related information. Link connection information specifies
characteristics of the link itself, while network-related information specifies
characteristics of the network the link is connected to. This information must
be specified before you can use the link definition. The values you specify
must match your X.25 network subscription.

Default values are provided for the X.25 links profile. These defaults should
be sufficient for most configurations. When completing this profile, make sure
the Link name parameter value matches the Link name defined in the DLC -
X.25 profile.

Creating or Changing Virtual Circuits for a Selected Link: Permanent
virtual circuits (PVCs) are configured for a chosen link by selecting the
PVCs... push button on the X.25 Links window.

Switched virtual circuits (SVCs) are configured by specifying the desired
number of virtual circuits and the lowest logical channel number on the
Virtual Circuit Ranges window (accessed from the X.25 Link Parameters
window).

X.25 Directory Entries Profile
The X.25 directory is a table that associates user-provided directory entry
names with the X.25 network address for your local data terminal equipment
(DTE) and the remote DTEs that you communicate with. You can use these
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names (rather than actual addresses) with the X.25 support in applications
that establish connections with remote DTEs.

This feature lets an application be independent of configuration. For example,
the application would not have to explicitly specify the link name, remote
DTE address, or remote DTE address extension, but instead could refer to the
directory name.

The types of directory entries that you can configure are:
v SNA permanent virtual circuit (PVC) directory entry

You associate a name with a remote DTE that you communicate with using
SNA applications or SNA APIs on a PVC.

v Non-SNA PVC directory entry
You associate a name with a remote DTE that you communicate with using
the X.25 API.

v SNA switched virtual circuit (SVC) directory entry
You associate a name with a remote DTE you communicate with using
applications or SNA APIs on an SVC.

v Non-SNA SVC directory entry
You associate a name with a remote DTE that you communicate with using
the X.25 API on an SVC.

The use of a directory is optional for X.25 API applications but is required for
SNA applications that use X.25 support.

The types of directory entries are:

Local Assigns a link name to your local DTE. Because the workstation can
be connected to multiple X.25 networks, you can specify a different
network address (and address extension) for each of up to eight
different network connections in each local directory entry.

The Local Directory Entry window associates a directory entry name
with a local X.25 link name. The local directory entry allows a name
to be assigned to local data terminal equipment (DTE).

Using directory entries, X.25 application programs can make and
receive calls without specifying the details of X.25 network addresses
and links.

Remote
Associates a link name with a remote DTE that you communicate
with using a PVC or SVC. There are two types of remote entries:

SNA Create this type of entry if you want to use any of the SNA
applications or SNA APIs when communicating with a remote DTE.
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Non-SNA
Create this type of entry only if you are only going to use the X.25
API to communicate with a remote DTE.

Virtual circuit type
Indicates whether the virtual circuit is switched (SVC) or permanent
(PVC).

X.25 Routing Table Profile
X.25 can support up to 40 applications concurrently. When it receives an
incoming call packet from the network, it must determine which application
to route the call to. X.25 uses the routing table to make this decision.

The QLLC protocol is provided when running SNA applications with X.25. In
addition, IBM has defined the Enhanced Logical Link Control protocol
(ELLC). All IBM products that support ELLC also support QLLC. The routing
table is configured by IBM with two ELLC entries (SNAELC80 and
SNAELC84) so that the X.25 DLC can receive incoming calls from SNA DTEs
requesting a connection for ELLC operation and handle them appropriately.
The table also includes two QLLC entries (SNAQLC80 and SNAQLC84).

It is recommended that if you want to only run SNA applications, you do not
change the routing table. If you plan to use applications that use the X.25 API
and need to receive incoming calls from the network, you need to create your
own routing table entries.

Restoring an IBM-Supplied X.25 Routing Table: If you delete one of the
IBM-supplied default routing table entries, you can either create another
configuration file or create the table entry again using the values indicated
below.

SNAELC80 - SNA ELLC (1980)
Routing Table Entry Name: SNAELC80 Type: SNA Call User
Data: C6 Priority Sequence: 1 Link Name: All links Called
Address and Extension: * Calling Address and Extension: *

SNAELC84 - SNA ELLC (1984)
Routing Table Entry Name: SNAELC84 Type: SNA Call User
Data: CE Priority Sequence: 2 Link Name: All links Called
Address and Extension: * Calling Address and Extension: *

SNAQLC80 - SNA QLLC (1980)
Routing Table Entry Name: SNAQLC80 Type: SNA Call User
Data: C3 Priority Sequence: 3 Link Name: All links Called
Address and Extension: * Calling Address and Extension: *

SNAQLC84 - SNA QLLC (1984)
Routing Table Entry Name: SNAQLC84 Type: SNA Call User
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Data: CB Priority Sequence: 4 Link Name: All links Called
Address and Extension: * Calling Address and Extension: *

Configuration Hints and Tips for X.25 Links Profile
Following are some points to remember when configuring the X.25 Links
profile.

Autoconnect Disconnect Delay Timeout:

It is recommended that you specify a 55-second autoconnect
disconnect delay timeout on the Modem Parameters window if you
specified the Transpac VX32 modem while defining the X.25 link.

Additional Parameters:

On the X.25 Link Parameters window, you can specify the appropriate
parameter values for integrated services digital network (ISDN) using
this field. It is available only when you specified ISDN as the adapter
type.

On the B-channel, you can configure a permanent connection or
incoming or outgoing call directory entries for each ISDN X.25 link.
On the D-channel, configuring an incoming call directory entry is only
necessary if the notification class is conditional or unconditional.

If you want your X.25 ISDN connections to always be initiated
remotely, you need to configure an incoming call directory entry. If
you want to always initiate a connection to the ISDN network, you
need to configure an outgoing call directory. If you want to do both,
you need to configure an incoming call directory entry and an
outgoing call directory for each X.25 link.

For both incoming and outgoing call directories, the X.25 subsystem
passes the directory name to the connection manager when it attempts
an outgoing call or when it requests that the connection manager
calls. The connection manager then uses the information in the
directory when planning an outgoing call or screening incoming calls.

Link Name:
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If you are using X.25 DLC, the Link name field must match the link
name defined in the X.25 DLC profile.

Local CCITT (ITU-T) Compliance:

On the X.25 Link Parameters window, packet sizes and PVCs are
dependent on this choice. If you change from 1984 to 1980 or from
1988 to 1980 (Xpander card only), you can create an error condition if
you have configured packet sizes larger than 1024 bytes.

Operation Mode:

You specify your modems operation mode on the Modem Parameters
window. When defining your X.25 link parameters for the modem,
you should select DTE when connecting your workstation to a
network. Partner mode lets you connect your workstation to another
X.25 DTE directly, for example, through a modem eliminator or a pair
of modems and a connecting line, without an intervening network.

When in Partner mode, your workstation acts like a data
circuit-terminating equipment (DCE) device. This allows you to make
a high speed (up to 1.5 Mbps) point-to-point connection with another
X.25 DTE, for example, a 37xx communication controller running the
Network Control Program Packet Switching Interface (NPSI).

When you connect two workstations back-to-back (using two modems
or one modem eliminator), one must be configured as a DTE and the
other as a partner (DCE). All other link parameters configured for the
two workstations must be the same.

Virtual Circuit Ranges:

When you are defining your X.25 link parameters, configure at least
one PVC or SVC in order to use an X.25 link. Select Virtual circuit
ranges from the list of Additional parameters. This information can
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be found on the form that the network provider returned to you when
access to the network was requested. This information must be
specified by you before the link profile can be used.

Virtual Circuit Range Restrictions

Figure 2 shows the relationship between the virtual circuit ranges for
permanent virtual circuits (PVCs) and switched virtual circuits (SVCs).
SVCs include incoming-only, two-way, and outgoing-only SVCs. The
following restrictions apply:

Figure 2. Virtual Circuit Range Restrictions
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v Virtual circuit 0 can be used only when the user is attached to the
Transpac network and has subscribed to the logical channel zero
option. Otherwise, virtual circuit 0 is reserved exclusively for the
transmission of restart, diagnostic, and registration packets.

v Virtual circuits from lowest PVC (LPC) through highest PVC (HPC)
is the range allocated for PVCs. LPC can range from 1 through 4095
(or from 0 through 4095 for Transpac).

v By convention, DCEs assign the lowest available logical channel
number to incoming virtual circuits, while DTEs assign the highest
available logical channel number to outgoing virtual circuits.

v Virtual circuits from lowest incoming-only SVC (LIC) through
highest incoming-only SVC (HIC) is the range assigned to
incoming-only virtual circuits.

v Virtual circuits from lowest two-way SVC (LTC) through highest
two-way (HTC) is the range used for either incoming or outgoing
virtual circuits.

v Virtual circuits from lowest outgoing-only SVC (LOC) through
highest outgoing-only SVC (HOC) is the range assigned to
outgoing-only virtual circuits.

v All virtual circuits below LPC, between HPC and LIC, between HIC
and LTC, between HTC and LOC, and between HOC and 4095, if
any, are non-assigned virtual circuits.

v PVCs are always active. To avoid frequent rearrangement of virtual
circuits, not all virtual circuits within the range allocated for PVCs
are necessarily assigned.

v In the absence of PVCs, virtual circuit 1 (0 for Transpac) is available
for LIC. In the absence of PVCs and incoming-only SVCs, virtual
circuit 1 (0 for Transpac) is available for LTC. In the absence of
PVCs, incoming-only SVCs, and two-way SVCs, virtual circuit 1 (0
for Transpac) is available for LOC.

v The actual value for a PVC or SVC can be from 1 through 4095 (or
from 0 through 4095 for Transpac).

v For 1980 and 1984 CCITT compliance, the maximum combined
number of PVCs and SVCs (incoming, two-way, and outgoing) that
can be configured for a link is 128. For 1988 CCITT compliance, the
maximum combined number of PVCs and SVCs (incoming,
two-way, and outgoing) that can be configured for a link on the
Xpander adapter is 4095.

v For 1980 and 1984 CCITT compliance, a maximum of 64 PVCs can
be configured for a link. For 1988 CCITT compliance, a maximum
of 4095 PVCs can be configured for a link on the Xpander adapter.

v In a peer-to-peer environment with a modem eliminator, a DCE
with an incoming-only SVC and a DTE with an outgoing-only SVC
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is not supported. In this environment, a DCE and a DTE with a
two-way SVC is supported, a DCE and a DTE with an
outgoing-only SVC is supported, and a DCE and a DTE with an
incoming-only SVC is supported. When the DCE and the DTE are
both configured with outgoing-only SVCs, the link should be
activated from the DTE. When the DCE and the DTE are both
configured with incoming-only SVCs, the link should be activated
from the DCE.

X.32 Signal Handling:

You can specify X.32 signaling in the XID Identity and Signature
window for your synchronous and autosynchronous modems after
you define your modem parameters. You must do this if your
network requires X.32 signaling procedures for identification and
security.

Configuration Hints and Tips - X.25 Directory Entries Profile
Following are some points to remember when configuring the X.25 Directory
Entries Profile.

Local Address:

Some networks require that the call request packet not contain a
calling address field. No entry should be made in this item for those
networks.

X.25 User Facilities:

If you are defining an SVC directory entry, you can define the X.25
optional facilities supported by your network provider on the
Optional User Facility Parameters window.

The most common of X.25 optional facilities are closed user group and
network user ID. Closed user group provides a form of security for
X.25 networks where many different companies share the same public
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network. Network user ID enables the transmitting DTE to provide
billing, security, or management information on a per call basis to the
DCE.

A hexadecimal entry field is supplied for entry of any optional
facilities.

Configuration Hints and Tips for X.25 Routing Table Profile
Following is a point to remember when configuring the X.25 Routing Table
Profile.

Call User Data:

The Call user data parameter is used in the Routing Table Entry
window. For non-SNA entries, you must type the call user data in the
entry field. For SNA entries, choose from the supplied values.

SNA Phone Connect Profiles

This chapter describes the SNA Phone Connect profiles that you can
configure. The following sections contain more information:
v “Introduction”
v “Asynchronous Switched Connectivities” on page 157
v “Asynchronous Leased Line Connectivities” on page 157
v “Synchronous Switched Connectivities” on page 158
v “Synchronous Leased Line Connectivities” on page 159
v “AutoSync Connectivities” on page 160
v “X.25 Network Access Using SNA Phone Connect” on page 160
v “Configuring SNA Phone Connect” on page 162
v “Profiles” on page 162
v “Configuration Hints and Tips for SNA Phone Connect” on page 162

Introduction
SNA Phone Connect takes advantage of wide area network (WAN)
connectivity over switched and nonswitched lines. Automatic dialing
capabilities are supported for asynchronous (SNA over Async), synchronous,
and auto-synchronous communications for modems.

SNA Phone Connect uses automatic switched call management: outgoing calls
are placed only when the need for a link is detected; incoming calls are
automatically answered; and unused links are automatically disconnected.
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Connections using SNA Phone Connect can be made over standard analog
public switched telephone networks, digital networks, or integrated services
digital network (ISDN) at speeds up to 64 Kbps.

SNA Phone Connect provides a status window that displays status when a
call is initiated and then disappears when the call is connected.

The SNA Phone Connect connection types are:
v Synchronous data link control (SDLC)
v X.25
v Integrated services digital network DLC (IDLC)
v GDLC for adapter-provided DLC

Applications written to the following APIs can also use the auto-dial
capabilities:
v APPC
v CPI-C
v LUA

Asynchronous Switched Connectivities
You can use switched (dial-up) asynchronous connections using SNA Phone
Connect with the serial communication port (COM Port) in your workstation.
You can use up to 16 serial communication ports at the same time. You can
also use adapters configured as serial ports, such as the IBM PS/2
MultiProtocol Adapter/A, the IBM PS/2 Dual Asynchronous Adapter/A, or
internal modems. The maximum speed supported for asynchronous
communication through a modem is 115.2 kbps.

You can use the SDLC protocol for asynchronous switched connections.

Using SNA Phone Connect support for switched asynchronous, the following
connections are possible:
v Connections to an AS/400 for 5250 emulation, LU 6.2 applications, or 3270

emulation using pass-through to an S/390 host
v Connections to the Advantis** network for 5250 emulation and LU 6.2

applications
v Connections to another system such as Personal Communications V4.2 or

Communications Server running features or applications such as gateway
or APPC

Asynchronous Leased Line Connectivities
You can use leased line (nonswitched) asynchronous connections using SNA
Phone Connect with the serial communication port (COM Port) in your
workstation. You can use up to 16 serial communication ports at the same
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time. You can also use adapters configured as serial ports, such as the IBM
PS/2 MultiProtocol Adapter/A or the IBM PS/2 Dual Asynchronous
Adapter/A.

You can use the SDLC protocol for asynchronous leased line connectivities.

If you are using a leased line through a public switched telephone network
(PSTN), you can use any modem that supports the type of leased line you
have (2-wire or 4-wire). Refer to your modem documentation to configure
your modem for an asynchronous leased line connection.

You can also use a null-modem cable or a modem eliminator to connect two
workstations using asynchronous leased line connection using SNA Phone
Connect.

Synchronous Switched Connectivities
Synchronous switched (dial-up) connections using SNA Phone Connect are
supported with the following hardware options:
v IBM Multiprotocol Communications Adapter (73G7099)
v IBM PS/2 MultiProtocol Adapter/A (MPA)
v IBM Wide Area Connector (WAC) for Micro Channel and AT/ISA/EISA bus

workstations

Note

You need the IBM WAC MAC Version 2.0; Version 1.0 does not
support auto-dial capabilities.

The following 16 physical interfaces on the IBM WAC adapter are supported
for switched connections using SNA Phone Connect:
v RS232D/V.24 interface for data transfer rates up to 19.2 Kbps
v V.35 interface for data transfer rates up to 64 Kbps

You can use up to 16 ports or adapters, including both ports on the IBM WAC
adapter. You can only use one MPA in your workstation for synchronous
switched connections using SNA Phone Connect.

You can use both the SDLC and X.25 protocols for synchronous switched
connections; however, the X.25 protocol can only use the IBM WAC adapter.
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If you are using SNA Phone Connect support synchronous connections with
the IBM MPA, make sure you have the latest adapter level.

Using the SNA Phone Connect support for switched synchronous, the
following connections are possible:
v Connections to an Advantis network for 3270 emulation
v Connections to an S/390 host system
v Connections to an AS/400 host for 5250 emulation, LU 6.2 applications, or

3270 emulation using pass-through to an S/390 host
v Connections to another system such as Personal Communications V4.2 or

Communications Server running features or applications such as gateway
or APPC

v Connections to a public or private X.25 network

Synchronous Leased Line Connectivities
Leased line support for synchronous connections through the IBM
MultiProtocol Adapter is supported as an SDLC connection type.

You can use leased line (nonswitched) synchronous connections using SNA
Phone Connect with the IBM Wide Area Connector (WAC) adapter. You also
need the IBM WAC Version 2.0 medium access control (MAC) software. You
can use any of the four different physical interfaces that the IBM WAC
adapter supports:
v RS232D/V.24 interface for data transfer rates up to 19.2 Kbps
v RS422/449 interface for data transfer rates up to 1.544 Mbps
v V.35 interface for data transfer rates up to 2.048 Mbps
v X.21 interface for data transfer rates up to 2.048 Mbps

You can use up to 16 ports or adapters, including both ports on the IBM WAC
adapter.

You can use both the SDLC and X.25 protocols for synchronous leased line
connections using the IBM WAC adapter.

If you are using a leased line through a public switched telephone network
(PSTN), you can use any modem that supports the type of leased line you
have (2-wire or 4-wire). Refer to your modem documentation to configure
your modem for a synchronous leased line connection.

You can also use a null-modem cable to connect two workstations using the
IBM Wide Area Connector (WAC) adapters. Refer to the IBM WAC adapter
documentation and the TECHREF.FIL file on the IBM WAC adapter software
diskette for information on using a null-modem or a ″crossover cable″. You
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will also need to change some of the configuration parameters for the IBM
WAC MAC. Refer to the configuration parameter online helps for more
information.

AutoSync Connectivities
Use AutoSync connections using SNA Phone Connect to connect to
synchronous modems using a Hayes AutoSync compatible modem and the
serial communication port (COM Port) in your workstation. In the past, you
needed a synchronous communication adapter and a synchronous modem to
connect to another synchronous modem. The AutoSync capability in SNA
Phone Connect enables you to connect to a synchronous modem using a
standard serial communication port (COM Port) in your workstation and a
Hayes AutoSync compatible modem.

You can use both the SDLC and X.25 protocols for AutoSync connectivities.

Using the SNA Phone Connect support for switched AutoSync, the following
connections are possible:
v Connections to an Advantis network for 3270 emulation
v Connections to an AS/400 host for 5250 emulation and LU 6.2 applications
v Connections to an S/390 host system
v Connections to another system such as Personal Communications V4.2 or

Communications Server running features or applications such as gateway
or APPC

v Connections to a public or private X.25 network

X.25 Network Access Using SNA Phone Connect
Use SNA Phone Connect to access an X.25 network or data communication
equipment (DCE) over either switched or leased lines. You can use the IBM
Wide Area Connector (WAC) adapter for both Micro Channel and AT/ISA bus
workstations and a synchronous modem. You can also use the standard serial
communication port and a Hayes AutoSync modem. The X.25 subsystem also
provides X.32 XID protocols, which are required by some public packet
switched data networks (PSDNs).

All SNA functions and applications that use X.25 in existing configurations are
enabled for accessing the X.25 network using the SNA Phone Connect. All
non-SNA X.25 applications that currently use the X.25 API provided are also
enabled for accessing the X.25 network using the SNA Phone Connect feature.

X.25 Using a COM Port with AutoSync
You can use the standard serial communication port (COM Port) to access an
X.25 network or data communication equipment (DCE) if you have a Hayes
AutoSync compatible modem. In the past, you needed a synchronous
communication adapter and a synchronous modem to connect to an X.25
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network. The AutoSync capability in SNA Phone Connect enables you to
connect to a synchronous modem using a standard serial communication port
(COM Port) in your workstation and a Hayes AutoSync compatible modem.

Note

Only switched connections are supported using AutoSync
modems.

X.25 Using the IBM WAC Adapter
You can use the IBM WAC adapter in either the Micro Channel or the
ISA/EISA/AT bus workstations and a synchronous modem to connect to an
X.25 network. Both switched or dial-up and leased lines are supported. The
device driver for the IBM WAC adapter is on the CD-ROM in the
\DRIVERS\IBMWAC subdirectory.

Switched Connections Using SNA Phone Connect: Switched connections
using SNA Phone Connect to access the X.25 network are supported using
either the RS232D/V.24 interface (for speeds up to 19.2 Kbps) or the V.35
interface (for speeds up to 2.048 Mbps).

Use any synchronous modem that supports V.25 bis call setup protocols with
the RS232D/V.24 interface. You can use any CSU, DSU, or other such device
that supports V.25 bis call setup protocols with the V.35 interface.

Note

Only the bit-oriented protocol for V.25 bis call control messages
is supported. Asynchronous or character-oriented V.25 bis
protocols are not supported.

Leased Line Connections Using SNA Phone Connect: Use any of the four
physical interfaces supported by the IBM WAC adapter for leased line access
to an X.25 network. Leased line connections are also referred to as permanent
connections or nailed-up connections.
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You can use any modem, CSU, DSU, or other such device that is compatible
with the physical interface of your IBM WAC adapter.

Configuring SNA Phone Connect
To configure SNA Phone Connect, select a profile from the list displayed on
the Profile List window after you select the connection type.

Profiles
Following are discussions of the types of SNA Phone Connect profiles. While
completing a profile, use the online help for a description of the parameters.

SNA Phone Connect - Connection Manager Profile
The connection manager uses and manages all port connection managers
defined at the workstation. The connection manager profile is like setting up a
telephone book. You create outgoing call directory entries for other systems
that your workstation will call. You create incoming call directory entries to
receive and accept incoming calls from other systems. This profile is not
required if you are using nonswitched (or permanent) connections.

SNA Phone Connect - Port Connection Manager Profile
The port connection manager controls communication hardware ports and the
modems that are attached to the communication hardware through the
medium access control (MACs) devices. The port connection manager
initializes the communication hardware ports and the modems. For example,
it instructs the hardware port and the modem to initiate an outgoing call. The
port connection manager profile defines the type of modem connection, port
name, and port characteristics.

Your workstation can use the following connections supported by SNA Phone
Connect:
v Asynchronous switched connections
v Asynchronous leased line connections
v Synchronous switched connections
v Synchronous leased line connections
v AutoSync connections
v ISDN connections
v X.25 connections

Configuration Hints and Tips for SNA Phone Connect
Following are some points to remember when configuring SNA Phone
Connect.
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Type of Subfield to Create

Tip

The types of subfields available for configuration depend on the
network switch type installed at your location.

When you are in circuit mode, the Bearer capability (for ISDN),
Modem/Line Characteristics (for X.21, V.24, and V.35
connections), and Called party number subfields are required for
an outgoing call directory entry. Although you can save a
directory entry without defining these subfields, you will not be
able to connect successfully without them. When you are in
packet mode, the Called party number is not required.

You can specify multiple Called party number subfields. The
connection manager serially tries them in order to connect to the
remote computer. That is, if the first number cannot be reached
for any reason, the connection manager tries the second number.
It tries all of the numbers you have configured one time until it
makes a connection. If it does not make a connection in the first
series of tries, it does not try anymore.

Coexistence with other COM port applications

Tip

If you are using the serial communication (COM) port for
asynchronous or autosynchronous SNA Phone connections,
Personal Communications claims sole ownership of the port
when it starts. If other applications try to access the port while
Personal Communications is started, these applications might fail
or an active connection might be lost. To avoid these problems,
stop Personal Communications before you start any other
application that uses the same COM ports.
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Appendix F. Notices

References in this publication to IBM products, programs, or services do not
imply that IBM intends to make these available in all countries in which IBM
operates. Any reference to an IBM product, program or service is not intended
to state or imply that only IBM’s product, program, or service may be used.
Subject to IBM’s valid intellectual property or other legally protectable rights,
any functionally equivalent product, program, or service may be used instead
of the IBM product, program, or service. Evaluation and verification of
operation in conjunction with other products, programs, or services, except
those expressly designated by IBM, are the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood,
NY 10594, U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact:

IBM World Trade Asia Corporation Commercial Relations
IBM Kamiya-cho Building, 4-3-9 Toranomon, Minato-ku
Tokyo, Japan

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

Site Counsel
IBM Corporation
P.O. Box 12195
3039 Cornwallis Road
Research Triangle Park, NC 27709-2195
USA

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement.
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This document is not intended for production use and is furnished as is
without any warranty of any kind, and all warranties are hereby disclaimed
including the warranties of merchantability and fitness for a particular
purpose.

Trademarks

The following terms are trademarks of the IBM Corporation in the United
States or other countries or both:

ACF/VTAM
Advanced Peer-to-Peer Networking
AnyNet
APL2
Application System/400
APPN
AS/400
AT
CICS
CICS/MVS
Client Access/400
DisplayWrite
Enterprise System/9000
ES/9000
FFST/2
First Failure Support Technology/2
GDDM
IBM
IBMLink
IIN
Micro Channel

NetView
OfficeVision
OfficeVision/400
OS/2
OS/400
Personal System/2
PROFS
PS/2
SAA
System/36
System/370
System/38
System/390
S/390
Systems Application Architecture
SystemView
TalkLink
ThinkPad
VTAM
Windsurfer
400

PC Direct is a trademark of Ziff Communications Company and is used by
IBM Corporation under license.

UNIX is a registered trademark in the United States and other countries
licensed exclusively through X/Open Company Limited.

C-bus is a trademark of Corollary, Inc.

Microsoft, Windows, and the Windows 95 logo are trademarks or registered
trademarks of Microsoft Corporation.

Other company, product, and service names, which may be denoted by a
double asterisk (**), may be trademarks or service marks of others.
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